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Chapter 1: Getting started \

This chapter will provide you a general overview of SCIA Engineer. It contains the general interface, the
options, and the project data.

1.1. Graphical user interface

The graphical user interface (GUI) of SCIA Engineer contains the following elements:
Graphical window, Main menu, SCIA Spotlight, Status bar, Properties panel, Viewbar (with Navicube), Input
panel and the Process toolbar.

[# sCIA Engineer - o x

DG % @@ oo a) ——— S
hiainment SCIA Spotlight Status bar [ &
PROJECT DATA (1) Y
Licence name
Licence number
Properties Shiradeate
() panel R .
[:‘ No. of nodes
[ILL No of beams
3 Process ot
il tOO[baI’ erWbar S No of used profiles
=] [F No. of load cases
=9 No of used materials
lﬁ\* i ~ DEBUG
& 1 Fulltree (3 )
= !
S
g W
I7 I
x Input panel =
= INPUT PANEL & Al workstations -
i Bn All categaries & Almgs -
GHE RS ’ ae ﬁ.&a
‘ a Fed © ™)
1.1.1. Graphical window

The Graphical window takes the entire screen. The other elements of the GUI are shown on top of the
Graphical window. Some of these elements have a fixed location on the screen and others can be moved to
any location.

1.1.2. Main menu

The Main menu is located at the top left corner of the screen (fixed location).
This menu contains all action-related functions and is closely related to the Input panel (that contains all input-
related functions).

For every function in the Main menu, it is possible to assign a shortcut by clicking at the right side and inputting
the shortcut.

) Saveall Save all
1= Rt St | o
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1.1.2.1.

File

With the File menu you can manage your project files (creating, opening, saving, importing, updating exporting,
closing), access the project settings, and exit SCIA Engineer.

5 o clAZLﬂ-m Project data k pe

= 1 Basicdata Functionality Actions Unit Set Protection
5 A

% D ﬁ‘ @ @ - | pata MATERIAL
. ; ;- Concrete
=5 Project browser Name: oner

Steel [
eli jal 5235 v ..
New Ctri+N Material
Masonry
Description: -
 Open Bl
Open from > Author: SCIA Timber
_ Steel fibre concrets
Recent projects 3 Dats;  23.04.2021 i
[B) Projectsettings »

Ry Structure: %1 General XYZ ¥ CODE

o R ) Mational Code:

1 Post processing . =
[ save Ceri+s APt @ acaut [ v[3
Saveas Ctrl+Shift+5 Model o5 - Moo =npec

Belgian NBN-ENNA ¥ |
b saveall B N e :
Update from » =
oK Cancel
Export as 3 =
Print »
X Close Project Ctrl+F4
Close all
B Qi Alt+Fa

1.1.2.2. Edit

With the Edit menu you can modify (move, copy, rotate, ...) objects, properties, add data and metadata. You
can edit polylines, curves, solids and calculate member end-cuts.

I B
i eom

| [+ Move CerisX
| q{i % i 4 @ f:'] g [ copy cerlvc
|\ = H}- Multicopy
< Undo Ctri+Z A\ Mirror
#> Redo Ctrl+Y I} Rotate Ctri+R
#, Divide surface
Modify L4 > M Join surface
@ Copy/paste properties Ctri+Shift+F T & Connect members/nodes
Add data » X Deletenode |e Disconnect members/nodes
Metadata » ¢? Breakinto curves
: &2 Connect curves O arcbyangle u| scake
Polyline edit b S T £\ Arc by bule ;r!’ stretch
Curves edit > > ) Arc by radius e
- {7\ Bezier weight factor e
Solids » 2 Comertounetsine = Enlarge by defined length
Calculate member end-cuts > D convertlineto circiearc 3 Breakin defined points
i > Convertline to parabolic arc E Joiry

) Convert curve to bezier Esnlbreakin iietesiiche

Reverse orientation

v

j} Convert curve to spline
s Align

8 BV —2024/06/03



1.1.2.3. Tools

The Tools menu contains a variety of tools, like the calculation & mesh, tools for making selections, the BIM
toolbox, coordinates info, tools for creating and filling the Engineering report, ...

:‘_TQOLS T B Calculate i} Selectall

. % Hidden calculation
X W g © 2 ‘a B2 Auocn
| Calculation & Mesh b > @ Solver settings Load selection
. = @ Generate mesh i Bymouse
l Live load reduction @ Vesh sttings £ By cutout
Selections . > F-'-'I By intersection
£ By polygon
i Byworkplane
=§ Generat solid to 1D ¥
BIM toolbox p—p = TSR '
&7 General solid to 20
¢ Clash check )
i Toggle deselection mode
ﬂ‘f Check structure =% Partof a general solid to 1D =, Toggle single selection mode
3 3 ¢ &= general solid o .
o Coordinates info Ctri+Shift+D u R Toggle visibility selection mode
=] Align
| 2% Cleaner
@ Report » [} Liveimageto report
[ tiveimagen scale to report
i » 41 Screenshot to rey
e port
l E Design groups settings LS imageto galery
LY Si ta file
[a] XML file B e
XML Copy image to clipboard
[zi3 Edit profile library ‘@ Tabletoreport
1.1.2.4. Results

With the results menu you can access the (solver) results that are available after the calculation of the structure.

| RESULTS

I@@@_r&ﬁﬂh

Supports
1D members

2D members

Yy v v v

Storeys
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1.1.2.5. Design

The design menu offers all features for the design and check of steel members and connections, aluminium
members, timber members, concrete 1D and 2D elements, composite elements, ...

| f_% ® 1 fa
= Steel members »
Steel connections b
Aluminium »
Timber >-
Concrete settings »
Concrete 10 3
Concrete 2D 13
SRFC 2D members 3
Compaosite »
Geotechnics p-
1.1.2.6. View

In the View menu, we discover all features for the Visibility (f.k.a. Activity) settings, the Clipping box, settings
for the UI, colour & line settings, the configuration of the line and dot grids, ...

le
i T k.

\ A7 Bylayers
4~ Byworkplane
Visibility 'S > A7 By clipping box
Zoom »
Views b
5 Toggle
Clippingbox 5 » L
e New T s
| Visualization » & ove [T Draw invisible members
. @ Giobalul setljngs (B Around selected entity
: Around all entities
User configuration » 8 yucs
aj Colours & lines [iE) connect to warkplane
i 2 : 4| Alphanumeric editin;
of Line grid manager Ctri+Shift+G & £

[ Graphic editing

% pot grid settings

’F‘— Wired model in view manipulations

10 BV —2024/06/03



1.1.2.7. Libraries

The Libraries menu is very important and extensive because it contains the links to all libraries that are linked
to SCIA Engineer. When working in a project, then the required library items are always copied to and saved
with that project.

| LIBRARIES 1% Load cases
. i¥7 Load grou
i Flegssclic el
> J\Ej%‘ @ L ﬁi Combinations
g Layers 33 Nonlinear combinations
' Materials CtrliM nf Stability combinations
niz Result classes
Iy Cross sections Ctrl+d | § Bucking groups
[E] Image gallery T Mamed item
| a= o Effective section properties
Paperspace gallery 255 Mass groups L’ oo
5 Combination of mass groups ‘ ez
Load cases, combinations » EJ_ o ¢ Febricated CSS & product range
1 Seismic spectrums —
Loads 3 2 ; i
Dynamics H m"?,‘mw
Structure and analysis b+ >
Tools »
Steel »
Concrete, reinforcement »
Prestressing b
Composite b
Subsoil and foundation »
Fire heat »
Drawing tools »
1.1.2.8. Help

The Help menu offers a link to the onboarding tutorials (concrete, steel, ...) and a direct link to the online help
pages of SCIA Engineer. With the ‘Share your screen...’-feature you can share your screen with our support
respresentatives.

N — m Concrete basics
} Replay onboarcing 4 > % Concrete 1D reinforcement
Er Video tutorials w Staci basics
Q@ Search help —_
% Free loads
{} What'snew..
B2 Steel plates
Check for update
m Share your screen...
Feedback »
1.1.3. SCIA Spotlight

The SCIA Spotlight is located at the top middle part of the screen (fixed location).

L
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The SCIA Spotlight has several functions:

1.1.3.1. Searching for a specific command
\Repo b _ o ®
B Report

Fp Tabletoreport
[} Liveimage to report
ra
Li3; Screenshot to report
[l Liveimage in scale to report

In the SCIA Spotlight there are 2 buttons: you can search the online help for the inputted search string, and
you can clear the inputted search string.

o [ Searcr wece

Repo ) R@

st S e |
_-_Repo 0 @R

1.1.3.2. Adding a shortcut to a specific command

By clicking at the right side of the window, a blue line appears at the bottom and this allows us to define a
shortcut for this specific command.

Report

g Tabletoreport

() Liveimageto report L2 =
:] Screenshot to report [G -

[ Liveimagein scale to report

There are 2 buttons available for each command: you can search the online help to see all available information
about this command.

Report
ﬁ Table to report SEARCH HELP

[) Liveimageto report | %?

(e )
(i1, Screenshot to report

[} Liveimagein scaleto report

12 BV —2024/06/03



You can also use the Show Me button to show where this command is in the Main Menu. In this case the Main
Menu it automatically opened, and the command is highlighted.

& SCIA 20006
DG X wm«@ © o @ | =
Calculation & Mesh » '[B) Report |
Live load reduction I ﬁ Tane fosepa | SHOWME
Live image to report =)
Selections , P—. 0%
(£, Screenshot to report
' [ Liveimage in scale to report
BIM toolbox » L
@ Clash check
ﬂ- & Check structure
H {i Coordinatesinfo Ctrl+Shift+D
H'-!' I}‘F Cleaner .
| Report
| B
o6 L Send = 2 ._ [ tiveimage to report ——
% Design groups settings [ tiveimage in scale to report
1 @H"ML file B :::] Screenshot to report
[z Edit profile library S image to gallery
= il Ey Saveimagetofile
| Copy image to clipboard
& 7 - * 5
g Tableto report \
1.1.3.3. Input field

The information in the SCIA Spotlight will guide you through the different steps when executing a command.
It also offers a place to input data (like e.g., the X, Y and Z coordinate of a point, ...) and it offers contextual
menus (like e.g., for changing the line type from a straight shape to a parabolic shape, ...)

A DS ™
_\3.14.15.9 |} . 0@
«/CnNnnNnS 5

1.1.4. Status bar
The Status bar is located at the top right corner of the screen (fixed location).

wy OWM = 2 m e | E

It contains items to select the Active load case selection, or to configure the snap setting, the User coordinate
system tools, the Units, ...

BV —2024/06/03 13
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Active load case Snap settings User coordinate system  Units
selection SNAPPING |_COORDINATESYSTEM [ GeomeTy LencTH NI |

[=;
i (=29 % e v [ lﬁ' v WM !_'"_%
= LC1- Self weight & MagnetSnapeing. D (O ST M Unitsystem  Metric }
= 102 Perm Tracking Guides 7 @0 = SAL i vorpanc Unit Metre
YZ XZ workplane = z
= LC3-Var tnegrid 3 OO o d = Manage units
_— — = Move Fo
= Manage load cases Ctrl+L botgrid %1 @) = L:_ e
om i
Endpoints/ Nodes % ({l[) Lo 2
= from Local Member F10
Midpoints [ Centers @ (O ) =
i Reset to GCS positi
For easy overview and Feetns 0 () A Resetto 6CS posiion cut-F11
. . From Line (align X axis)
SW|tCh|ng Normal&Tangent = (O ) B
1 -V Rotate
Linedivisions () w
— {ZX Align Z to X axis
Pontsonline %, (O ) . ,
L = {2V Align Z to Y axis
B surfaceedges M (O d ? Align normal to View
Solid vertices (@ (D) |- Flip Z axis
o Switch workplane F11

(& Previous UCS
(£ NextUCs
" Save Current UCS

= Load UCS »

== UCS Manager

The Autorefresh toggle can be used to automatically draw results when a result property is changed.

NI I
=4

The Results lock toggle can be used to ‘lock’ the current results — the results will not be deleted when data
(that affect the result) in the project is changed.

RESULTS LOCK

LIS Ml G

The Grid mode toggle can be used to enable ‘editing’ the grids. A grid can normally (grid mode = OFF) only
be used as snaPping points. But, when you want to edit the grid, then the Grid mode must be toggled to ON.

The scale settings for input data (e.g., size of support symbol, arrow length of load, ...) and for result data

Ee.g., size of results diagram) can be modified.

2v O M= s %
Scaleadddata 3 ..—
Scaleresultdata 1 ..—

L : e Y
== Scalesettings

The settings for the National code and National Annex can be set.
] |

14 BV — 2024/06/03



1.1.5. Property panel

The Property panel is located — by default — at the right side of the screen (but can be moved to any location).

The property panel displays all properties of the selection. You can easily check or modify the properties by

using this window.

_ lcons show the list of items in the

Z|

MEMBER (3) v
—

Layer Layerl v o= Click on an icon to show the
properties of that entity.

=

» .
| selection.

Icons show the list of ‘related’
items to the selected items.

z|

MEMBER (3} > LAYER (1)

g A =

Type N
= . Name Layerl
Analyz:::: :':::::: Drag icon onto the Bin to unselect Comment
/ remove these elements from the Siructuralmedelonty €3 2
Cross-section €51 - IPE248 :_.—: Se|eCtI0n Current used activity ([
Alpha [deg]  0.00 Nope (1)1 "I
Member system-li... Centre ¥ The properties of the ‘related’ items

8.

1§

are visible and can be modified.

ey [mm] 0.00
ez [mm] 0.00
LCS standard -~
LCS Rotation [deg] 0.00
¥ BUCKLING

Systemn lengthsa... Default ~ —

Material and no. ...
Secondary member () )
¥ GEOMETRY

Length [m] o

Right-clicking on a property allows to modify the current selection. We can isolate the entities with only this
property from the entire selection, or we can expand the current selection and add all entities with this property,
or we can subtract all entities with this property from the entire selection.

AP
= MEMBER (3) t>
g A 4
Layer Layerl v ==
Type b
Analysis model  Standard
FEM type  standard *~
Cross-sectig =
{H Isolate selection f
Expand selection 5
i=# Subtract from selection
ez [mm] 0.00
= LeS  standard v
rF. LCS Rotation [deg] 0.00

It is possible to reduce / increase the number of properties that are shown for a particular item. The list of
properties can be shown in basic mode (with only a few properties visible) or advanced mode (with all
properties visible).

By clicking on the chevron at the right top side of the Properties Panel, you can switch between these modes.

BV —2024/06/03 15
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Advanced mode

¥

MEMBER (1)

Type
Analysis model
FEM type
Cross-section
Alpha [deg]
Member system-line at
ey [mm]
ez (mm]
Lcs
LCS Rotation [deg]
¥ BUCKLING

System lengths and buckling...
Material and no. of parts
Secondary member

¥ GEOMETRY
Length [m]
Shape
Beg. node
End node

w NODES
N2T

N28
S8
¥ [LLUSTRATION GROUP

B15

Layerl
column (100}
Standard
standard
CS1-HEA200 ~
0.00

Centre

0.00

0.00

standard
0.00

BG1

ao

N2T

N28

ACTIONS 22>
@ Table edit geometry

1.1.6.

Basic mode
Z

(&)

o Type

Layer

Cross-section
Member system-line at
ey [mm]
e ez [mm]
LCS Rotation [deg]
v GEOMETRY

Length [m]

w |LLUSTRATION GROUP

/‘.‘-\
oy

ACTIONS 3%
(3 Tableedit geometry

MEMBER (1)

@\Qez

Layerl o=
column (100)

CS1 - HEAZOO =
Centre

0.00

0.00

0.00

- -‘Jz

Viewbar (with Navicube)

The Viewbar and Navicube are located at the bottom right corner of the screen (fixed location).

The shortcuts for view settings enables the quick adjustment of the view parameters. The following pictures
provide a graphical representation of all the options.

Volumes OFF or ON

16
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Rendering ON -- Transparency OFF and ON

Transparency
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Support symbols OFF or ON

TOGGLE SUPPORTS

i i
i i
i Fd
! i
‘TUGGLE‘_MODELDATA @
.F% 4
s I "

=

4

L
i
i
!
g
L
TOGGLE MED_J_BEF LABELS IE%

-

HEE o 3@

elll

Qe s

ﬁ:} A s

Apply to selection O'I‘:F or ON

&

With this setting ON, then the view-setting changes
are only applied to the elements in the selection.
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Loadcase selection — Load symbols OFF or ON

7
7 =log
l M
L1 ;
| = Lé*
e 1
e I
- s
s

Node labels OFF or ON

i i

i N2

i X

: !

g 8

_TOGGLENDDELABELS I’I’- ‘ﬁ
=~ s N

e - o

% ®

Qe s - ﬁ} (o1& P : m‘i}

Dot and Line grids OFF or ON

e

[ O]

3Dgrid  All grids

Show 3D grids

Qe s

gQ o, LiSs@™ =

N n:

More options button

R Y

Effective width of plate ...

o« s

Structure nodes [ 9
Member parameters 2B
Local axes P =%
System length labels [ S} LC_DQ
Nonlinearity labels (@D
Labels of local axes [OD)] Q
Structural shape labels W) l’ﬁ’*
Mare view settings shlﬂv—ctrl;-\-!- it o

settings.

This allows a more in-depth configuration of the view

17



Basic Concept Training - SCIA Engineer 24

1.1.7. Input panel

The Input panel is located — by default — at the bottom middle of the screen (but can be moved to any location).

The Input panel is the core element that is used for inputting data in the project.

= INPUTPANEL [\ | 838 Al workstations v ————9 F Mworksatons Ty — e
2 Structure ». Grids & Storeys Basic modelling
= All categories ~ —— 1 & All tags v | toads | 1D members Quick input
2 Dynamics 2D Members 0D, Point
P Calculation & Results Load Panels 1D, Line
@ % '-.f-i““-' @ @ “ff - steel Import & Blocks 2D, Surface
| Concrete Prestressing Member Data
i I = [0 = E w & ﬁ a’ ﬂ @ Composite Boundary conditions
Aluminium Model modifiers
1 ? Timber Drawing
Q ] E -~ » Geotechnics Volumes & Open Shelis
- - R 1 1 7 3 Point loads
E E‘ H |:| @I A 4 AL Line loads
. 4 Surface loads
@ i A & b :rq & o LC "By Temperature loads
= = Imposed displacements

There are several filtering options available to filter out just these options that you need.
You can filter (simultaneously) on workstation, on category and on tag.

Filter on Workstation = Loads Then, filter on Category = Line Loads
= INPUT PANEL
= All categories v @ All tags ~~
S e o & & A M e = INPUT PANEL # oads
3 ¥ o g dFaa & Altags -
Il 223 [Ee] :{'f

With the hamburger menu, it is possible to configure the Input Panel: with the Icon mode toggle you can switch
between icons and icons + descriptions, and with the Show category headers toggle you can switch on or off
category headers for the icons.

INPUT PANEL &= g
MIN/MAX auto open @
Icon mode @f
Show category headers CD
1.1.8. Process toolbar

The Process toolbar is located — by default — at the bottom left corner of the screen (but can be moved to any
location).

The process toolbar is the main element on the screen that allows you to fully personalise the graphical user

interface of SCIA Engineer.
It is composed of ‘workstations’, which represents the logic stages in the normal workflow of entering a project.
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The icon bars of the The active workstations In the configuration

s horizontal and vertical are shown in the menu, you can
O workstations are sho doughnut. activate multiple
] with user-defined Left-clicking-on a workstations (max
functions. button activates the simultaneous = 8)
e iconrbar of the
& horizontal workstation. sructre @) @7
B Thedittle icon on the-right Ctrl+Left-clicking on a == & O
; de swaps the-icon bars  button activates the toscs 3 @2
& of the horizontal and icon bar of the vertical . 2 f
O vertical workstation workstation. Concee @ (D
™ Composite v CD
: With the little icon on the Aluminium g &9
left side you can drag the Timber @@ D
=) process toolbar to Reports @
* | another position uy workstation ¥ @

In the centre of the

doughnut, we have the Their icons will appear
button to start the in the doughnut.
calculation.

1.1.8.1. Adding an item to the icon bar of a workstation

Adding an item to the icon bar of a workstation can be done by a Drag-and-Drop operation of a feature from
the Main Menu or from the SCIA Spotlight.

Drag and Drop from the SCIA Spotlight An icon can be dropped...
...to the right of an existing icon, or

DG ¥ m& © 1 ‘A

B
B
i)
=
[*]
B
£
[}
B |1='0' 4
= @ @
1.1.8.2. Deleting an item from the icon bar of a workstation

Deleting an icon from the icon bar of a workstation, can be done Drag-and-Drop operation of this icon onto the
Bin.
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1.1.8.3. Saving the configuration of the Process Toolbar

The configuration of the Process Toolbar can be saved to a configuration file via Main Menu > View > User
configuration. This allows you to create multiple configurations (depending on the type of project), or to
migrate your settings to another computer, or another version of SCIA Engineer.

®© 1 fa

& Undo view change

Visibility
Zoom
Views

Clippingbox

vy v wv w w

Visualization

@ Global Ul settings

' User configuration » rg_‘ Save L\,
- Colours & lines }
.__- . rg‘ Load
By Fonts settings B Restore default
- Structural beam tvpes settings
1.1.9. Marking Menu

The Marking Menu is an invisible menu which you can call for at any location by holding ALT and clicking on
the right mouse button:

By hoovering over the 4 submenus you can access SCIA’s most basic functions, we give you an overview of
these in the chapters below. A more detailed explanation about these functions can be found further down
this manual.

1.1.9.1. Model

In this submenu you can find the most used functions to built up your model:

B - 1D member
~ s - Column
F@ - Plate
> é - Panel with load to 1D & edges
j b - Hinge on 1D
2~ - Support in node

MODEL
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1.1.9.2.
VISIBILITY
1.1.9.3.
I
r'h <>
A
Z N
) b
8 &~
MODEL
1.1.9.4.
0 -
~ T
A -

BV —2024/06/03

Visibility

In this submenu you can find the most used functions to change
the visibility of your model:

' - Hide selected
r'~ <>
L - Hide unselected

A - Make layers visible
Modify
In this submenu you can find the most used functions to modify your model:
- Move
- Copy
- Multicopy

- Break in defined points
- Connect members/nodes

- Disconnect members/nodes

Load
In this submenu you can find the most used functions to apply loads to
your model:
LOAD - Point load in node
g - Point load on 1D

- Line load on 1D

- Line load on 2d edge
- Surface load on 2D

- Free surface load

21
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1.2. Global Ul settings

In this chapter the most essential settings in the Global Ul settings menu are explained. You can find the Global

Ul settings menu in Main Menu > View.

1.2.1. Environment

In the Environment tab, you can alter the Rendering and Antialiasing settings.

If the graphics card of your computer is having issues with rendering, the following settings must be decreased.

Environment Templates & directories Other

Ul SETTINGS

Global Ul settings *

Rendering Hardware OpenGL hd

Antialiasing quality Hardware multisampling v

Hidden lines  Invisible

Display surfaces intersections

Line pattern length- 3 v
Select pen width [pixel] 2 v
Transparency 12% =)
Tooltips [
Labelzs [
Maximum no. of entities for selection ‘All' 100
| COMMAND SETTINGS
End functicn Right mouse button click to end
Bypassinputdialog  Hold Shift b
| NAVICUBE HOTHKEYS | NAVICUBE MOUSE KEYS MARKING MENU HOTKEYS
[ t
q‘}p o .,.:,. q h
| ’
| ¥ ~ -
- - b
P
* 4
5 b
- i o=
B &8 oK Cancel

22
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1.2.2. Other

In the Other tab, you can select the language that will be used in SCIA Engineer. The workspace (GUI) and
the output can have different languages.

Global Ul settings >
Environment Templates & directories Other
AUTOSAVE
Enable autosave
Autosave every 15 minute(s)
Clean files
Clean files every 10 day(s)
Atmost 20 file(s)
Disable when results calculated
LANGUAGE DEFAULT*
Application  English (United States) v
Output  English (United States) v
SYSTEM
FastOpen for documents
MemSave (swapping unused objects)
Product improvement program
QUESTION BEFORE DELETING RESULTS
Confirm deleting results
Calculation time tresheld 10
B] IE'I a Cancel

NOTE: only the installed languages are shown here. You should also have the language module(s) to

be able to use them.

BV —2024/06/03
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1.3. Project settings

The first action that you need to perform while starting a new project, is to define the project data. The project
data window consists of the following tabs: ‘Basic data’, ‘Functionality’, ‘Actions’, ‘Unit Set’ and ‘Protection’.

1.3.1. Basic data

In the ‘Basic data’ tab you define some specific data for your project.

Project data X

Basic data Functionality Actions UnitSet Protection

DATA MATERIAL
Mame: - Concrete {,’j;,l ~
Material C25/30 w ..
Fase Reinforcement m B 500B ~ ..
Steel
Description: - o .
Author: - Masonry
Aluminium
Date; 29.01,2024 Timber
Steel fibre concre
Other v
Structure: @ General XYZ v CODE
National Code:
B o v
National annex:
“ Standard EN v
oK Lancel

» Material: choose the materials that you want to use in your project and the default value of the quality.
» Code: select the code and national annex you want to apply.

*  Structure environment:

1@ Only 1D-members, 2D environment, axial force only
@ General Xz - 20 Only 1D-members, 2D environment
1 B2 Truss X2 - -
2 ) Frame Xz I Only 1D-members, 3D environment, axial force only
3 @R Truss Xz 4. Only 1D-members, 3D environment
4 " Frame Xv¥Z
5 € Grid XY 5 & Horizontal grate
S f.‘)' F:'f‘: :‘: 6 & 1D-members, 2D-members, 2D environment (Horizontal)
t)f Wall X
8 g General Xz 7 1D-members, 2D-members, 2D environment (Vertical)
8 4t Everything
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1.3.2.

Functionality

In this tab you need to check the functionalities that you want to use in SCIA Engineer. SCIA Engineer will

automatically turn on some functionalities based on the basic data set.

Project data

Basic data

Functionality Acdtions UnitSet Protection
| GENERAL
Property modifiers
Model modifiers
Parametric input
Climatic loads &
Mobile loads
Dynamics
Stability
Nonlinearity ﬁ
Structural model §.
IFC properties
Prestressing
Bridge design
Construction stages

DETAILED

4 Nonlinearity

Beam local nonlinearity |24

Support nonlinearity/basic soil = 54

Initial imperfections
Geometrical nonlinearity
General plasticity
Compression-only 2D members
Cables
Friction support/Soil spring
Membrane elements

4 Subsoil
Soil interaction
Pad foundation check

4 Steel

Plastic hinge analysis
Fire resistance checks

Steel connections

0K

Cancel

*

1.3.3.

Actions

In this tab you can set the acceleration of gravity, the wind load, the snow load, the model factor for pond loads,

the factor for concomitant components of a seismic combination and the automatic code combinations.

Project data

Basic data

Functionality Actions Unit5et Protection

Acceleration of gravity 9,8 10 [ A
WIND LOAD
According to code b EC1/26,200m/s/ Il

SNOW LOAD

According to code v

SEISMIC COMBINATIONS

Factor for concomitant components 0,30

CODE COMBINATIONS

B Automatic -

| EC1/Sk=1,00kN/m"2 Ce=1,00 Ct=1,00

OK

Cancel

X

BV —2024/06/03
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1.3.4.

Unit Set

In this tab you can change from metric to imperial units, and via the Unit dialog you can configure the units
used in the project.

Project data >
Basicdata Functionality Actions UnitSet Protection
TYPE OF UNITS
* Metric format
Imperial format
Unit dialog
oK Cancel
1.3.5. Protection
In this tab you can password protect your project.
Project data >
Basicdata Functionality Actions UnitSet Protection
o Protected operation Open X
Current password
New password
Mew password ﬁ_F_'Pl)’ |
Hide parametric properties
oK Cancel

26
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_Chapter 2: Modelling

2.1. Line grid

To insert a line grid and/or storeys, go to the input panel and choose the category ‘Grids & Storeys’.

INPUT PANEL

=
|E All workstations >~
i= Grids & Storeys >

| & Alltags v
G HE B S

Free line grid
By using this option, you can draw free lines to create or to add to a line grid.

Rectangular grid / 3D line grid
In this menu you need to define the distance dx,y,z between two lines of the grid and the amount of lines (Rep).

3D Line grid
Inputdata Drawing setup
= k]
' 3
T o~
H {fs N )
R/Y COOrERNYY
* Ade 8B
DIRY [M] | DIRY M) | DIRZ 4]
Type |Span ” Type | Span v Type |pan v
Mame X[m] dx[m] Rep SL Mame ¥ [m] dy[m] Rep SL Name Z[m] dz[m] Rep SL
1 A |o,ooo ne v 11 0,000 o v 1 a 0,000 o v
Lol 0,000 0,000 0O v . 0,000 0,000 0O v » 0,000 0,000 0O w
[ Generate name automatically [ Generate name automatically | [ Generate name automatically
[ -
I Rotation 0,00  deg | Refreshnames |
Mame Geidl Type  Catesian |
| OK || Cancel ||
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Circular grid

To insert a circular grid, you need to define a distance dx and a rotation dy.

Line grid

Name

Input data for 2D Line grid

X [m]
0,000
0,000

[ Generate name automatically

Type
clx [m]

0,000 o

| Span

Rep SL

DIRY

[ Generate name automatically

Name

¥ [deg]

j 0,00

0,00

Type

dy [deg]

0,00

OK

Q9 X
ange v
Rep SL
no v
] ¥
Cancel

Storeys

You can create different storeys and choose how elements are assigned to those store

Storey manager

*

12—
M3
g om——|
L2
+a00——|
[
ALl
Y 3
+ojo——
Mame Z-Bottom [m] Height [m] Repetition Z-Top [m] Description
1 FL1 0,000 4,000 3 4,000
2 FL2 4,000 4,000 8,000
3 FL3 8,000 4,000 12,000
4 FLa 12,000 0,000 1 12,000
Insert Delete Inserting point X 0,000 Y 0,000 m Cancel

S.
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2.2. Views, visibility and layers

2.2.1. Views
There are 2 ways to change the view in the model.
1. Using shortcuts
« CTRL + right click = rotate the model
»  SHIFT + right click = move/pan the model
e SCROLL = zoom in/out
2. Using the Navicube

FRE:r ey FiE s ,—i‘«%
= w\?

With the Navicube you can change the view in an
» Left click = rotate
* Right click = zoom

@ O

@

PRANY

easy way:

» Clicking on a plane will give you a view perpendicular to this plane

«  Clicking on a corner will give an orthogonal view (from this point)

2.2.2. Visibility

In SCIA Engineer you can use ‘Visibility to hide/show elements.

®© @ fa

| ‘B Undo view change

Visibility > £ Toggle
Zocul 2 B Hide unselected
{ %@ | 5 Hideselected
= Clippingbor ’ - Hide layers of selected members
Visualization = | e
a . & By layers
) Global Ul settings |
> @ g A~ Byworkplane
User configuration > _;r By clipping box
-\:LT;.Co[ours& lines &8 By storey
o Line grid manager Ctrl+Shift+G | |
31 Dot grid settings
< Wired model in view manipulations
" Tl ti [T Draw invisible members

BV —2024/06/03

Ctrl+Q

Ctri+E
Ctrl+D

Ctri+W
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2.2.3. Layers

You can open the ‘Layers’ menu by going to Libraries > Layers

1= Layers W
& -t B O oa v Y

: R-1 [z Mame R+1 |
{®o yes Comment

: E:; 1:5: Colour [N |
[ R+3 no Structural moc no

| R+4 e Current used a yes

| Dimensions no

I

I

I

I MNew Insert Edit Close |F

You can create layers in this window. There are 2 checkboxes which you can check or uncheck.

» Structural model only: if this is checked the elements in this layer will not be taken into account in
the calculation.

» Current used activity: if this is unchecked the elements in this layer will not be visible.

You can assign elements to a layer by selecting them and changing the layer property.

2.3. Selection

When you hold the left mouse button, you can create a selection box to select multiple elements.

Selection box with full line: this is created by dragging the mouse to the right. With this selection box, you
will only select the elements that are entirely in the box.

Selection box with dashed line: this is created by dragging the mouse to the left. With this selection box, you

will select all the elements that are partially in the selection box. In other words, you will select all elements
fully in the box + all elements that cross the box.

Next to selecting with the mouse, you can make some automatic selections and you can also save a current
selection. This way you can load a previous made selection easily. You can find these options via Tools 2>
Selections.
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2.4. View settings for all entities

You can open the window ‘View parameters setting’ by right clicking > View settings for all entities. In this

menu you can edit the view settings of your project.

View parameters setting View parameters setting - Labels
Lock postion Lock postion
1 BEstrudure  [Eabeis  [EModel  EModelling/Drawing @ attributes PPIMisc.  [&]view { BEstucure  [EEJLabes  [E]Model B atrivutes  PlMisc.  [@view
[®] Check / Uncheck all ||(| ] check / Uncheck al
B Service B Sevice
Display on opening the service v Display on opening the service Ir2
O Structure B Beam labels
narmal Set colors by property | Display label [l
Draw member system line it I Name v
Member system line style system line | Cross-section name |
Model type analysis model = |
Display both models Length [
Member surface [l Layer |
Rendering wired | Type and priority [3
Draw cross-section Bl Nodes labels
Cross-section style section ~ Display label |9
1 Effective width of plate ribs Name Ica
Draw effective width v X-coordinate '
Rendering transparent -l ¥-coordinate ]
B Structure nodes Z-coordinate ]
Display 2 B System lengths
Mark style Dot = Display label Ica
] Member parameters Name v
System lengths [l Label |
Member nonlinearities L B Nonlinearities
FEM type ~ Display Iabel 3
Joists (s B Labels of local axes
1 Local axes Nodes |
Nodes |} Members 10 (1
i [ General structural shape
Display vertex label IT]
i Show names in tab H = 0K Roply Cancel i’ Show names in tab B & o ook Caneel

Some of the most used view parameters are highlighted:

» Colours by property: you can set the colour of elements in the model by element type, cross-section;

« Displaying local axes;

» Displaying the cross-sections type.

2.5. Material database

You can open the material database by going to Libraries > Materials. In this window you can view all the

activated materials and their different qualities. When you click on a material, you can edit its parameters.

B Materials % [
18- IERHFE «a2» O SA@mB A v Y
C35/45 Name C35/45 ~ I
e 4+ Code independent 4
: ;220;:5 Material type Concrete
S275 Thermal expansion [m, 2,00 L
5355 Unit mass [kg/m*"3] 2500,0 :
5450 Density in fresh state [k; 2600,0
5275 N/NL Time dependency of un None v
7 5355 N/NL E modulus [MPa] 3,4100+04 I
1 5420 N/NL Poisson coeff. 0,2 r
> 460 NNL Independent G modulus i
5275 M/ML
S 355 M/ML G modulus [MPa] 1,3208e+04 .
S 420 M/ML Log. decrement (non-ur ©,2 ]
S 460 M/ML Colour |
S235W Specific heat [J/gK] 6,0000e-01
S Temperature dependen None v
z;zg S":QL":QLJ- Thermal conductivity [V 4,5000e+01 r
5275 H Temperature dependen None v
5355 H Order in code &
S 275 NH/MLH Price per unit [€/m"3] 1,00 r
S 355 NH/NLH 4 EN 1992-1-1
DTN Characteristic compres: 35,00
S Calculated depended va
S 355 MH/MLH e aien y
New Insert Close

BV —2024/06/03
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2.6.

Cross-sections

You open the cross-section database by going to Libraries > Cross sections.

MNew cross-section

Available groups

o Profile Library

: Concrete

|:||:|Timber

: Geometric shapes

Mumerical

%Y General

1L Pairs

ML Closed

ﬁ Haunch

I welded

TT Sheet welded
] H

AVAILABLE ITEMS OF THIS GROUP

CS[NER)
CVS(MER)

HiJIS)
HD

HD ARi

HEA
HEE

HEC
HEM

HG[GOST)
HHD
HL

o L] N L] Y5

| 3le|=|lOO

HL[5Z5)
HMICH)
HN(CH)

I Thin-walled geometr
A Precast
T Eridae

Composed symm bric
mm -

HP
HP(ARC)
HP(ARCUS)
HP(GERD)

Mame

HE100A

10044
100B
100C
100M
12044
1204
1208
120C
120M
14044
1404
140B
140C
140M
160AA
1604
160B
160C
160M

ArcelorMittal / Sales Programme / Version 2012-1
Furonean wide flanse heam

Profile Library filter

All cross-sections v

ftems in project

Add

Close

In the picture above the most used cross-sections are highlighted.

« Profile Library: you can find all standard (tabulated) profiles in the library.

« Concrete: you can use this option to create a concrete cross-section.

» Geometric shapes: with this option you can create a geometric cross-section. However, it is not
advised to use this option. This will result in a thick-walled cross-section (buckling curves d) for steel.
When you select this type of profile for concrete, you need to modify some settings. The best practice
is that you use the option ‘Concrete’ for a concrete cross-section and the option ‘Thin-walled’ for a

steel cross-section.

e Numerical: this option can you use to add a numerical cross-section. You can assign all the
parameters to this cross-section without giving it a surface in the 3D-view. You can use this type for
dummy elements.

* General: with this option you can draw a custom cross-section.

« Pairs: with this type you create a paired cross-section which results in a fully cooperative cross-

section.

« Thin-walled geometric shape: with this option you create custom thin-walled (steel) cross-sections.

32
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When you add a cross-section, the following window will open.

B ! Cross-section

q 98 Picture 1T Fibres  Unit Warping

Cross-section lavout and dimensions

Shear (Vy)

[

N

General

Draw colour Normal colour

Colour NN

Fabrication rolled
Buckling curves
Edit buckling curves
Flexural buckling y-y b
Flexural buckling 2-z <
Lateral torsional buckling Default
Initial shape
Initial shape
Classification
Effective section
Advanced procedure
Fibres and Parts
Fibre text zoom 1.0

Edit pamad o

v

v

2D FEM analysis
Use 2D FEM analysis

Property Modificat...
Edit shear and torsion pre

Use property multipliers

Export Update

OK

Document

Cancel

In this window you need to set the parameters. In order to view the calculated properties, you can press

‘Update’. The properties of the cross-section are calculated when pressing ‘OK’.

Use 2D FEM analysis: when this option is not checked, the properties are calculated with some simple
formulas. If this option is checked, a mesh will be generated to calculate the properties. By checking this option
Ay, Az, It and Iw are calculated more accurately. This option is important to check — only for thick walled
sections — if the cross-section is experiencing torsion.

NOTE: when you use a cross-section of the profile library, you don’t need to set the settings above
since the parameters and the properties are tabulated.

BV —2024/06/03
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2.7. 1D elements

There are three ways to draw a 1D Member:

INPUT PANEL

é=  All workstations

= 1D Members -

@ All tags
é’ ; I ? F I T

Member: with this option you draw a 1D Member by defining two points. This element automatically has the
type ‘general(0)’ or ‘beam(80)’. You can change the shape of the member by using the toolbar below (it appears
under the SCIA Spotlight when you draw the member).

<./ . CnNnnNns§es %

Beam: with this option you model a horizontal 1D Member by defining a point, a length, a direction and an
insertion point. This element automatically has the type ‘beam(80)’.

Direct axis X v
Length [m] ©,000
Insertion point begin v

Column: with this option you can draw a vertical 1D Member by defining a point, a length and an insertion
point. This element automatically has the type ‘column(100)’.

NOTE: the type is important for defining connections, to perform the ULS check of steel and to
determine the calculation method in the ‘Concrete’ menu.

Next to the settings above you also need to set some other parameters:

B Column >

Mame B431
| ez
= d Type column (100) W

ey‘\ Analysis model Standard v
; Cross-section €52 - ecdge beams - Rectangle (300; v ...
@ .@% Alpha [deg] 0,00
Member system-line at Centre v
ey [mm] ©
ez [mm] ©
LCS z by vector v
¥ [m] 0,000
Y [m] -1,000
Z [m] 0,000

IZ
L
3 ®.\\ LCS Rotation [deg] 0,00

% : FEM type standard v

Layer R-1 Wi

P Buckling
P Geometry

= B COK g Cancel
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* Cross-section: set the cross-section.

« Alpha: rotate the member around its own axis. With this rotation you will not rotate the LCS (Local
Coordinate System). This means that the LCS is different from the strong and weak axis of the profile.

* Member system-line at: change the system line of the member.
* ey, ez: add an eccentricity

» LCS Rotation: rotate the member around its own axis. With this rotation you will rotate the LCS
together with the member.

« FEM type: here you can choose for a standard FEM analysis (bending + normal force) or axial force
only. This option only needs to be changed for members that are only subjected to a normal force.

« Layer: set the layer.

Difference between rotations:

a rotation No rotation LCS rotation

You can add 1D-member components to the elements. The type ‘Haunch’ is often used and is explained further
in this manual.

2.8. 2D elements

There are three different types of 2D elements:

INPUT PANEL
All workstations
2D Members -~
&7 Alltags ~~

waosged
Aleraa
a8

D &I®

Plates: you define this 2D element by drawing the edge. You can change the shape of the edge by using the
toolbar below (it appears under the SCIA Spotlight when you draw the plate). This element automatically has
the type ‘plate(90)'.

G000 AT NN S S
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Wall: this 2D element you define by drawing the baseline (bottom or top) and by giving it a height. This element
automatically has the type ‘wall(80)’.

Height [m] 3,800

Insertion point bottom )

Shells: you define a shell element by drawing the edge, by a surface of revolution or by a swept surface.

Next to the settings above you have to set some parameters:

B 20 member *

Name Walllle

Element type Standard o
Element behaviour Standard FEM
\ 2 Type plate (90) v
“bfd = rju‘ il Material C35/45 Vo
— _"—-T FEM model Isotropic v
B FEM nonlinear model none v
ez ~ > :
& ~ Thickness type constant
L Thickness [mm] 200 "
1 Member system-plane at Centre v

Eccentricity z [mm] @

z LCS type Standard v
. Swap orientation no

o X f LCS angle [deg] 0,00
Layer R-1 S

OK Canicel |

« Type: select the type.

* Material: select the material.

« FEM model: select the FEM model: ‘isotropic’ or ‘orthotropic’. An orthotropic plate has different
properties in perpendicular direction.

» Thickness: set the thickness of the plate. By default, you create a plate with a constant thickness.
You can change it afterwards to a variable thickness in the property panel.

* Member system-plane at: set the member system plane: top, bottom or middle.
« Eccentricity: add an eccentricity to the plate.

» LCS angle: change the angle of the local axis of the plate.

« Layer: set the layer.
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You can also add ‘2D Member components’ to a plate:
INPUT PANEL &% Al workstations

g All categories @ All tags
¥ GRIDS & STOREYS
@ HE @ @

w 1D MEMBERS

- o

w 2D MEMBERS
BYovgedqd e~ ==
2% 8

Subregion: create a subregion. This is an area of the 2D element that has another thickness and/or material
quality than the rest of the 2D element.

Opening: create an opening in the 2D element.
Internal node: create a node on the 2D element.

Internal edge: create an edge on the 2D element. 1D elements parallel with the plate are only connected to
the plate when there is an edge.

Rib: create a rib on the 2D element. A rib is automatically connected to the 2D element.
Integration strip: an integration strip makes it possible to view the result of a part of the 2D element as if it is a
1D member.

Intersection: create an intersection between two 2D elements. This will connect the 2 elements with each
other.

NOTE: the function ‘Internal node’ is only applicable to insert a node within the polyline of the element.
However, this function does not work when a node needs to be created on the edge of a 2D member.
In order to insert a node on an edge of a 2D member, you can use the option Edit 2> Polyline edit >
Add node.
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2.9. Load panels

A load panel is a 2D element that transfers the applied load to its edges or nodes. The load panel adds no
stiffness to the model.
You can find Load panels in the ‘Structure’ menu. There are four different types of load panels:

INPUT PANEL
& Structure
= Load Panels

@ Alltags
= R ~=2w»

Load to panel nodes: the panel transfers the load to the nodes of the panel.
Load to panel edges: the panel transfers the load to the edges of the panel.

Load to panel edges and beams: the panel transfers the load to the edges of the panel and the beams in the
plane of the panel.

Panel with parallel beams: same as the type above, however the beams will automatically be generated by
using this function.

After you have chosen the type of panel, you need to set the properties. It is not necessary to set all the
properties correctly before modelling the panel. You can modify the properties afterwards as well.

7 Panel x
Mame LP1
Panel type To panel edges and beams w
Load transfer direction X (LCS panel] g
Max.angle for transfer [deg] 5,00
LCS type Standard v
Swap orientation no
LCS angle [deg] ©,00
Layer R-1 , e
! Supporting members validity range (with respe Al »
Max. eccentricity of members [m] 9,200
Load transfer method Tributary area "
1 Selection of entities Autoselection v
OK fJ Cancel |

= = =
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» Load transfer direction: you can choose the direction in which the loads are transferred. This can be
direction X, Y or both. The X and Y direction follow the local axes of the panel.

* Max. angle for transfer: maximum allowed angle difference of an edge or beam, perpendicularly to
the load transfer direction, in order to transfer the internal forces.

* LCS angle: rotate the LCS.

* Max. eccentricity of members: maximum allowed eccentricity of the members. If the eccentricity is
higher than the set limit, the load will not be transferred.

* Load transfer method: there are four load transfer methods.

1) Tributary area: this method divides the surface in such a way that every separate part of the surface
is ‘carried’ by the beam lying on its edge. This means that the load on this part of the surface is
completely transferred to that beam. This method does not work for complex load panels. The
advantage of this method is the quick calculation of the loads.

2) Standard: this method uses weight factors to divide the load between the beams. You can set the
weight factors in the property panel.

Weight of loaded ed...
LP1/B1
LP1/B2
LP1/B3
LP1/B4

= =3 S

3) Accurate(FEM), fixed link with beam: this method generates a mesh on the panel and uses a
FEM calculation to determine the load distribution. For this option the beams have a fixed connection
to the panel.

4) Accurate(FEM), hinged link with beam: this method generates a mesh on the panel and uses a
FEM calculation to determine the load distribution. For this option the beams have a hinged connection
to the panel.

NOTE: the FEM method allows to determine a load distribution on underlying elements based
on the FEM response of an auxiliary plate with finite stiffness. The plate response is determined
prior to the analysis of the 3D structure (upon pressing the ‘Generate loads’ action button).

The boundary conditions of this auxiliary plate affect the load transfer from the panel to
adjacent elements and nodes. You can set the connection of the panels to the underlying
beams at the panel edges as rigid or as hinges. You may choose between two options: ‘fixed
link with beams’ or ‘hinged link with beams’, which results in different final load distribution.
The resulting reactions of the background calculation of auxiliary plates are converted to the
loads generated on the actual structure. In the case of ‘rigid link with beams’, moment reactions
are ignored, as these do not originate in the structural response.

» Selection of entities: the entities/beams on which the load is transferred, are automatically selected.
You can overwrite the automatic selection by changing this option to ‘user selection’ or ‘type’.
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When you select ‘user selection’ you need to press the action button ‘Update edge/beam

selection’ and select/deselect the members.

ACTIONS

(>) Update edge/beam selection

@ Update all load panels

@ Generate loads

@ Table edit geometry

When you select ‘type’ you need to check/uncheck the types taken into account.

w SELECTION OF ELEMENTS
general (0)

beam (80)
column (100)
gable column (70)
secondary column (60)
rafter (90)

purlin (0)

roof bracing (0)
wall bracing (0)
girt (0)

truss chord (95)
truss diagonal (90)
beam slab (99)

composite beam rib (92)

2.10. Supports

AAAAAAAAARAAAAA

You can input supports via the input panel.

INPUT PANEL
All workstations

Boundary conditions

NI

All tags

L TRRBELSLAQ

In node: you can only assign this type of support to a node.

Support on 1D: you can put this point support along the length of a member. You need to define the relative

or absolute position of this support along the length of the member.

¥ Support on beam

40

Name Sbl
Type Standard
Constraint Fixed
X Rigid
¥ Rigid
Z Rigid
R Rigid
Ry Rigid
Rz Rigid
Default size [m] 0,200

Extent full
System GCS
Coord. definition Rela
Position x 0,000
Origin Fromstart

Repeat (n) 1

<< |e|<|lx|%| <=

e
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Line support on 1D: you can put this line support along the length of a member. You need to set the relative
or absolute position and the length of this support along the length of the member.

Line support on 2D edge: this is a line support which you can define on a 2D member edge. You need to set
the relative or absolute position and the length of this support along the length of the edge.

Surface support on 2D: this is a surface support that you can define on a 2D element or a subregion. You
need to choose a subsoil in which the stiffness parameters define the boundary conditions. More information
can be found in the chapter related to subsoils.

Mame SS8
Type Indiviclual v

Subsoil Sub1 ¥ o

Next to the support position you need to define the constraints (boundary conditions) as well

4 7 Support in node X
Mame Snl
Type Standard v
1 Angle [deg]
Constraint Hinged bl
% Rigid v
¥ Rigid v
] Z Rigid v
1 Ry Free W
Ry Free v
Rz Free v

Default size [m] 0,200

4 Geometry

System GCS ¥

OK Cancel

« Angle: as default the support follows the local axes of the node. You can give it a rotation relative to
the LCS by using Rx(angle),Ry(angle),Rz(angle). For example: Rx90,Ry90,Rz90.

« Constraint: you can choose a default constraint: ‘fixed’, ‘hinged’ or ‘sliding’.

« X, Y, Z, Rx, Ry, Rz: you can change these values to set a custom constraint. Also flexible or non-
linear constraints are possible.

» Default size: this option is only used for the moment reduction above a support of a continuous beam
and punching checks (for concrete structures).

BV —2024/06/03 41



Basic Concept Training - SCIA Engineer 24

2.11. Catalog blocks

You can find the catalog blocks in the input panel in the “Import & Blocks” category.

INPUT PANEL

All workstations

oK B |1

Import & Blocks

CATMALO G BLOCKS
BB A

With catalog blocks you can import frames and trusses in an easy and fast way.

Block selection manager

4 Available groups AVAILABLE ITEMS OF THIS GROUP ftems in project

= N (Y

QBeam

FA Frame 3D

AR Tower
5 Truss 2D m
B8 Truss 30

B8 Truss 3D Arc
5 Truss 2D Arc

4 m Frame
OK Close

Select the predefined block you want to add to your model and set the parameters.

Geometry block X

Name BL

4 Geome...
L[m] 10,000
H1[m] 5,000 T

H2 [m] 1,500
Column €83 -ribs -Rv ...
Beam €53 -ribs -Rv ...

L 10,000

H2

HI1 5.000

H1

| ——
OK Cancel

After pressing ‘OK’ you can add the catalogue block to your model. The catalogue blocks consist of
1D members that are fully connected to each other.
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2.12. Haunch

In the Input Panel under category ‘1D Members’, you can find the function ‘Haunch on 1D’.

Before you can define a haunch, you need to add a cross-section of the type ‘Haunch’. This is the
cross-section at the beginning of the haunch, more specifically the largest cross-section. You can add the
cross-section in the ‘Cross-section’ menu OR you can click on the ‘Haunch’ function to automatically open this

window.

First select the type of haunch and press ‘Add’:

Mew cross-section

Available groups

l Concrete

I Geometric shapes
@ Numerical

ﬂE Pairs

E Closed

5 Haunch|

T welded

TT sheet welded

1 Build-in beams

I Thin-walled geometric
BN pracast

' Bridge

E Westok

E I+ var

= T
£ £

B Cross-section

zZ

| ——

2x IPE180

ES
N B
Tn%?‘ —
S
4 96 Picture  UnitWarpi.. Shear (.. Shear (..

Cross-section lavout and dimensions

1
L

L Centr... (b

Confirm with OK = Close - OK
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AVAILABLE ITEMS OF THIS GROUP

£
I

Profile Library filter All cross-sections v

ltems in project

£+ I
I

Add

Then you need to fill in the parameters of the cross-section.

Name C53 -ribs3 A
Type | +1var
Detailed IPE180;90
Shape type Thin-walled

Initial shape Mot available

Parameters
Material 5235 ¥ s
va [mm] 90
Isection IPE180
Profile Library filter Allcrosssections v

i

.

General
Draw colour Nermal colour -
Colour [T
Fabrication welded v
Buckling curves
Edit buckling curves
Flexural buckling y-y &
Flexural buckling 2-z ¢
Lateral torsional buckling Default
Fibres and Parts
Fibre textzoom 1.0
Edit named items
2D FEM analvsis b

Update Document

OK Cancel

€51 - columns - Circle (400}
C52 - edge beams - Rectan
53 -ribs - Rectangle (400;
€53 -ribs2 - T g (650; 1750:

Close
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In the last step you define the position (in the beginning or at the end of the beam) and the length (relative or
absolute) of the haunch.

5 Haunch on beam y

Tr—— ——_] Name H1
?X—I ’—X7> Position Begin =

1 Cross-section CS3 -ribs3 -1+ 1 var (IPE120;90) Vo

I—L\
] i Use from Ces no
‘r-—;.'.—J L‘H_‘“ va [mm] 20,0
-‘_“‘-‘_“ﬂ r-‘-_-f—- 4 Geometry
Coord, definition Rela =

Length x 0,500

OK Cancel

A haunch is model data you put on a member. This means if you select the surface of the member, you are
not selecting the member itself but only the additional data ‘Haunch’. In order to select the member, you need
to select the centerline.

Haunch H1 B1
——

liember B1 (6,000 m)-beam (30)

A haunch is calculated by the solver in 5 segments with each segment having its own, constant cross-section.
You can increase this number of segments in Tools - Calculation & Mesh > Mesh settings

o 27 Mesh setup x

Use automatic mesh r &

S

1D elements

Minimal length of bea 0,100
Maximal length of be: 1000,000
Average size of cables 1,000
Generation of nodes it

Generation of eccentr

I Division on haunches 5 I

Division for integratio 50

Mesh refinement follo None v

Method of haunch exp Constant parts v
4 2D elements
To generate predefine
| Maximal out of plane 30,0 v

B |2 | OK Cancel

NOTE: if you want to have a different haunch at the beginning and at end of a beam you need to cut
the beam in half.
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2.13. Hinges

By default, every node in your project is considered fixed, unless your project is modelled in a truss
environment. In order to make a member hinged, you need to add a hinge to the member. A hinge is considered
as additional data you add on a member.

You can find the hinges in the Input Panel under category ‘Boundary conditions:

INPUT PANEL
& All workstations
= Boundary conditions

@Atltagav
a8 8 444

1—1 A 4+ 4[]
oo

To add a hinge you need to define the degrees of freedom and the position (begin, end or both sides of the
beam).

# Hinge on beam ?
Mame H589
g Position Begin i
ux Rigid v
@1 :
u uy uz Rigid v
[0)4 w\;py fix Rigid v
fiy Free v
fiz Free v
1
Ok Cancel

The hinge is visualised in SCIA as in following figure:
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2.14.

Beam non-linearity

It is possible to add non-linear behaviour to a beam. To enable this option, you need to tick following
functionalities in the ‘Project’:

* nonlinearity;

e beam local nonlinearity.

You can find the option ‘Nonlinearity 1D’ in the ‘Boundary conditions’ category in the input panel. You need to
choose the nonlinearity type in the following window.

Qe

INPUT PANEL

All workstations
Boundary conditions

All tags

% 5% % S nonunearity 10 @

b BT A & *Eu o

co

B Beam nonlinearity

a) "1‘

b)

5 / 3

LA ¥

A

Z

e
g
i

)
)
o

el

&

u,

Name BN1
Type Press only A

Tension only
Limit force
Gap

Initial stress

i a] Tension-only 1D members
h) b) Press-only 1D members
/ ¢) Limit compression force combined with loss of stability
5| | d) Limit compression force combined with plastic behavior
&) Limit tension force combined with fragile failure
) Limit tension force combined with plastic behavior
gl Gap - no tension - modelling e.g. the instant when a 1D member
bears against a support
h) Gap - ne compression - modelling e.g. a fres rope
i) Gap - connected in both directions - e.g. a scaffold pipe

L § Cancel pgu

You need to perform a nonlinear calculation to consider the nonlinear behaviour. Therefore, you should create

nonlinear combination(s). Chapter 3 explains the creation of loads and combinations.

NOTE: the most used nonlinearity type is ‘Tension only’. It is used to model wind bracings. Best
practice is to combine the ‘Tension only’ type with the 1D member property ‘axial force only’. See the
chapter about 1D members to check how this is enabled.
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2.15. Subsaoil

If there is a 2D element in your model, you can add a ‘Surface support on 2D’ from the Input panel under
categorie ‘Boundary conditions’.

INPUT PAMEL
All workstations

Boundary conditions v

All t4 SURFACE SUPPORT ON 2D
vug[ss s ad
BHAF = % o o

T Qlm

o
Q

You can define a subsoil yourself, or you can import one of the predefined subsoils (according to NEN 6740)
from the library.

B Subsoils *

BEEREIFE «= ﬂ@lﬂ Al .

Subl

L Read from system database
System database

Cremrrrar—=y
Cly [MN/m"3] 5,0000e+01
Ciz Flexible v
Stiffness [MN/m"3] 5,0000e+01
C2x [MN/m] 3,0000e+01
C2y [MN/m] 3,0000e+01

4 Parameters for c...

Type Undrained v
Water/air in clay subgr:
Specific weight [kg/m*". 0,00
Fi' [deg] ©,00
Sigma oc [MPa] 0,0
cu [MPa] 0,0
New | Insert | Edit | Delete | 0K
B Read from database X
‘F‘roject database ISysiEm database
Subl (i v Y |

Gravel/Slightly silty/Loose - NEN 6740
Gravel/Slightly silty/Moderate - NEN 6740
Gravel/Slightly silty/Stiff - NEN 6740
Gravel/Very silty/Loose - NEN 6740
Gravel/Very silty/Moderate - NEN 6740
Gravel/Very silty/Stiff - NEN 6740
Sand/Clean/Loose - NEN 6740
Sand/Clean/Moderate - NEN 6740
Sand/Clean/5tiff - NEN 6740
Sand/Slightly sitty - NEN 6740
Sand/Very silty - NEN 6740
Loam/Slightly sandy/Weak - NEN 6740
Loam/Slightly sandy/Moderate - NEN 6740
Loam/Slightly sandy/Stiff - NEN 6740
Loam/Very sandy - NEN 6740
Clay/Clean/Weak - NEN 6740
Clay/Clean/Moderate - NEN 6740
== Copy to project
Close <= Copyall
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Now you should set the following parameters before adding the subsoil to your model:
» C1z: stiffness of the ground in Z direction.

» C1x, C1y: stiffness of the ground in horizontal direction. If these values are not known 10% of the
stiffness in Z direction can be taken as an approach.

» C2x, C2y: these values couple the deformation in Z direction between different sections of the ground.
The image below shows the theory of Winkler (picture a) where these parameters are 0. Picture b
illustrates the theory of Pasternak where the C2 parameters have a certain value. Usually these values
are not determined, and the values are set to 0.

Elastic spring

Shear layer

Elastic spring

2.16. Modify shape

There are three ways you can modify the shape of elements.
1) With property panel

You can change the shape of an element by editing the coordinates of the nodes of the element. If a node is
in the current selection, you can change the coordinates in the property panel.

o
NODE (1) A
@ F| P
Name NT97
2D member
Member
Intersection

v GCS COORDINATE

X[m] 7,00
¥[m] 46,50
Zlml 7,20

w UCS COORDINATE

ux[m] 0,00

uy [m] 0,00

uz[m] -3,60
v MEMBERS

Member

Member

Member
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2) With the action ‘Table edit geometry’

You can edit the shape of an element by selecting it and clicking on the action button ‘Table edit geometry’ on
the bottom of the properties panel.

ACTIONS 22
@ Table edit geometry

In this table you can edit the coordinates of the nodes of the element.

Editing geometry
Mode name X [m] ¥ [m] Z [m] ux [m] uy [m] uz [m] Linked Shape
1 N547 14,000 39,500 -3,600 7,000 7,000 -14,400 Rela Line
2 N54s 21,000 39,500 -3,600 14,000 7,000 -14,400 Rela Line
3 N516 21,000 39,500 0,000 14,000 7,000 -10,500 Rela Line
4 14,000 39,500 0,000 7,000 7,000 -10,300 Rela Line
o 0,000 0,000 0,000 0,000 0,000 O,000 Rela
< >
oK Cancel

3) By clicking and dragging

When you have selected a node, an element or several nodes, you can move these by holding the left mouse
button on top of it, clicking and dragging the mouse towards the new location.
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2.17.

Connect members

It is important to know that not all members are connected automatically. The scheme below provides a
graphical representation of all the members which you need to connect by yourself. The connect algorithm can
be found in Edit > Modify &> Connect members/nodes.

OK
Beams are connected

OK
Edges are connected

OK

Edge and beam
are connected

Structure menu

> Model data

> Connect members/
nodes

Structure menu

> Model data

> Connect members/
nodes

7
/
4

*Connect members/
nodes: only nodes

are connected

*Structure menu

> 2D Member

> 2D Member components
> Internal edge:

entire beam connected

y
y

/

Structure menu
> Model data
> Cross-link

Structure menu

> Model data

> Connect members/
nodes

ST

:77

*Connect members/
nodes: only nodes

are connected

*Structure menu

> 2D Member

> 2D Member components
> Internal edge:

entire beam connected
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2.18. Check structure data

As soon as you have completed your model and before you run the calculation, the ‘Check structure’ function
should be executed. This function checks if there are errors in the project, more specifically duplicate elements,

corrupt data, ...

Lﬁimﬁﬂﬁﬁﬁh

Calculation & Mesh 'S
lﬁ_ Selections >
!_g: _-!_J. i T |-::'!_'-|f
3l BIM toolbox >
|
B #% clash check

i Hv‘ Check structure

If there are no issues in the model the following window will appear.

Check of structure data X

CHECK OF NODES

__________________________________________________JB¥

[ Search duplicats nodes Ignore parameters
=== A A |
CHECK OF MEMBERS
Check members ;
Search null members Null members: o
Search duclicate members Duplicate o

Data check report x 4

CHECK OF DATA REFERENCES

Check data references Data check finished. nt method
[ —
CHECK OF ADDITIONAL DATA )
{7 Check additional data position Qo
Check free load distribution points Invalid loads o
%%
" =
0%
| Checkloadpanels | | Checkcrosslinks |
| Checkadditionaldata | | Check duplicity of names | Continue || Cancel

b e o
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2.19. Modification commands

In this chapter you can find some explanation about modification commands. The steps you need to follow to
successfully complete a modification command are shown in the command window. You can find the
modification commands under Edit > Modify.

G 7w @ © 1 fa

< Undo Ctri+Z
| 2 Redo Cari+y
fl  Modify * {[= Move cerl+X
f El’ Deletion settings Hi” Copy Ctrl+C
q Q’ Copy/paste properties Ctrl+Shift+F IH' Multicopy
Add data » Rl Mirror
[ iﬂad_a_‘a _____ » Q0 Rotate Ctri+R
Polyline edit » | #% Divide surface
1 Curves edit » Q| # Joinsurface
{ Solids » Q§§- Connect members/nodes
Calculate member end-cuts 3 |n- Disconnect members/nodes

AobBHA+=

oz =000 D A X z:ih
= L= '-l'f it < 7?8 Tim
® ® 'Or \_\ @ R ;E/‘ L) E Extend
é‘.ﬁ i" Enlarge by defined length
3 Breakin defined points
] Join
mtn Breakin intersections
& : Wl —, Reverse orientation
B eanay [Lw
2.19.1. Copy

Press the ‘Copy’ command or use the shortcut CTRL+C.
Below you can see the actions you should take to perform the copy command. You can find these steps in the
SCIA spotlight.

Copy - Select entities to be copied (finish selection with ESC) >
Copy - Start point >
Copy - End point >

2.19.2. Multicopy
In order to perform a more advanced copy, you can select the ‘Multicopy’ command.
Multicopy X
Number of copies + Connect selected nodes
with new beams
(2 Insert the very last copy Copy additional data
DISTANCE VECTOR HOW TO DEFINE THE DISTANCE ?
Define distance by cursor & between two copies
x 0,000 m from eriginal te the last copy
HOW TO DEFINE THE ROTATION ?
¥ 0,000
® between two copies "
z 0,000 m from eriginal to the last copy
ROTATION ROTATION AROUND
x 0,00 deg * current UCS
5 0,00 deg distance vector
0,00
e deg OK Cancel
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* Number of copies: set the number of copies.

* Insert the very last copy: this option defines the number you need to fill into the ‘Number of copies’
field. If this option is checked and the ‘Number of copies’ is 7, 7 copies will be made. If the option is
unchecked and the ‘Number of copies’ is 7, 6 copies will be made. The existing selection counts as
the first copy.

* Connect selected nodes with new beams: if this is checked, all the nodes in the current selection
will be connected with beams to the same nodes of the next copy.

« Copy additional data: when this is checked, all additional data of the selection (supports, haunches,
...) will be copied as well.

» Distance vector: setting values for this vector will define the distance/rotation between copies.

2.19.3. Mirror

Use the ‘Mirror’ command.
Below you can see the actions you should take to perform the ‘Mirror’ command. You can find these steps in
the SCIA Spotlight.

Mirror - Select entities to be mirrored (finish selection with ESC) >
Mirror - Mirroring plane - Start point >
Mirror - Mirroring plane - End point >

2.19.4. Break in defined points

Use the ‘Break in defined points’ command to divide a member into multiple segments.
Below you can see the actions you should take to perform the ‘Break in defined points’ command. You can
find these steps in the SCIA Spotlight.

Divide - Select curves to be divided (finish selection with ESC) >
Divide - Insert division points >
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2.20. Input table

In SCIA Engineer elements are often drawn, but you add them as well via ‘Input table’. The ‘Input table’ window
has a tab per type of element (nodes, 1D elements, 2D elements, ...). The tabs are highlighted in the picture
below. You need to fill in the green cells to add an element. If a tab is missing, you can add it by right-clicking
on another tab and choosing the missing tab. The same works for the column names.

INPUT TABLE R structwre A | [l | vperere g2 e Y P ylEH|X
4 MName X Im] Y [m] Z[m] Member 2D member
1 M 0,000 0,000 0,000 Bl
2 | m 0,000 0,000 3,600 BL: B3
3 | N3 | 5,000 0000 | 0,000 B2
4 | N4 5,000 0,000 3,600 B2; B4
5 NS 2,500 0,000 5,000 B3 B4

H vodes | F | & | 4| T | 5K | &

You can copy the content of the table to Excel and vice versa. In order to do this, you can use the short cut
CTRL+C.

You can copy rows in the input table to perform an action similar to the ‘Copy’ function. To do this you need to
select (the rows of) the elements, fill in the distance between the copies (separated by a space and preceded
by ‘@’) and then press the ‘copy row’ button.

| COPY ROW
= INPUT TABLE N structore A~ m v Eg‘ dg Y |El v |E(H | X
4 Name Type Beg.n... Endnode Cross-section . Lengt... Layer LCS Re... Meml
Bl column {100) | N1 N2 CS1 - Rectangle (400,00; 300,00) v Tm | 3,600 Layerl = 0,00 Centr,
B2 | column (100) v. N3 N4 CS1 - Rectangle (400,00; 200,00) b 3,600 Layerl = 0,00 | Centr
B3 beam (80) | N2 NS CS1 - Rectangle (400,00; 300,00) b 2,865 Layerl 0,00 Centr
B4 beam (80) | N5 N4 CS1- Rectangle (400,00; 200,00) i | 2,865 Layerl = 000 Centr

select rows
|

N

H | 95 1D members | &P & it gk -4

The input table offers multiple features such as a Filter, Select by property in cell, ...

FILTER BAR IN TABLE

= INPUT TABLE M stucwre A~ | [l | npehere
4 Name Type Beg.n... Endnode Cross-section FILTER CONDITIONS
Y P yol o jol Given the speficied condition, show
| | rows of the table where the value x in the
1 Bl column (100} ~ | N1 N2 CS1 - Rectangle (400,00; 300,00) v S
} | same column is such that...
2 B2 column (100) ~~ | N3 N4 CS1 - Rectangle (400,00; 300,00)
3 B3 beam (80) | N2 NS €51 - Rectangle (400,00; 200,00) e
| Xisegualtoo
4 B4 beam [80) | NS N4 C51 - Rectangle (400,00; 300,00) <>a:xisnatequaltoo
- <a:xislessthan g

<=a:xislessthan or equal to o
=a ;x is greater thana

>=a :x isgreater than or equaltoa
H | members | &2 | B | F | 5& | F {asb) or Jasbl :a <x<b

=a;b=or [a;bl:o=x=b

All operators are applicable to
numerical, text and boolean values
(theckboxes), as well as parameters.

For filtering boolean properties, use
values 1 for true and 0 for false
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Chapter 3: Loads

3.1. Load cases

For every load you can create a load case. In the settings of the load case, you determine if it is a permanent
or variable load and to what load group the load case is assigned. These two settings are important to
generate the correct combinations.

You can open the Load cases window via the Main Menu - Libraries - Load cases, combinations.

B Load cases X
- IZNHES «a» T @D M 23
LC1-Selfweight | Name LC1
Lcz Solver index (1]
Description Self weight
Action type Permanent v
Load group LG1 L
Load type Self weight v
Direction -
Stage for composite analysis model Construction stage v
New Insert Edit Delete Close
In the Status Bar, you can select the active load case to draw/define the loads:
|_ACTIVE L OAD. CASE
dow. oy B 2 @
¥ LC1 - self weight
mfi LC2
| *— Manage load cases Crrl+L

a5 Mass group

3.2. Load groups

With load groups you define the type of load and the relation between the loads in this group. Depending on
the type of load case (permanent or variable) you can define the matching load group.

3.2.1. Permanent load group

B Load groups
A eBE o> & - a

LG2

Name LGt

Load Permanent

There is only one permanent load group per project, because all the permanent loads should be summed up
and they do not have different categories.

Y 76 Gk ;' rpP"+" 701019k 1"+ X7 0.i%0.i0k i (6.10a)
Jz1 i>1

Z: $ive fGr, ;1" PP +" 01Ok 1"+ ZIYQ,:'V’D,iQk,i (6.10b)
Jjz i>
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3.2.2. Variable load group
B Load groups >
AaeBk 22 & - a mRvy;
LG1 Mame LG2
Relation Standard -
Load Variable -
Structure Building
Load type Cat A: Domestic -

Compared to the permanent load group you can define multiple variable load groups. For every type of load
(wind, snow, ...) you can create a different load group. This is because in 6.10a(b) the different type of loads
should vary between the main variable group and the sub variable group. The different types of loads are
defined by the option ‘Load type’. With the load type you can set the category of the load. This way the program
knows what psi factors to use (according to Eurocode 0).

Zl 6. Gk, j"+" Y pP"+" Vo Woh Ok 1 1+" }.;IJ’Q,r'V’ ReY (6.10a)
i i>

Zl &6, Gr "'y p P y o1 Ok 1|+ ZIYQ,.‘WC,;‘QJ:,: (6.10b)
Jz >

You should also define the relation between the loads in the same load group.

» standard: all combinations are possible.
« exclusive: only one load of every load group can be present in a combination.

« together: the loads can only be present together in a combination.

EXAMPLE: assume the load cases LC A and LC B which are both assigned to the same load group.
e standard: LC A and/or LC B
e Exclusive:LCAorLCB
» together: LCAandLC B

3.3. Combinations
You can choose between three types of combinations. The differences will be explained below. To add a
combination, go to the Main Menu - Libraries = Load cases, combinations and select Combinations.

By default, there are 3 Eurocode combinations automatically generated:

B Combinations X

I E |

¢, 2 [ Inputcombinations v
Mame ULS-Set B (auto)

SLS-Char (auto)
5L5-Quasi (auto) Type EN-ULS (STR/GEQ) Set B

Description

Updated automatically
Structure Building
Active coefficients
« Contents of combination

LC1 - Self weight [] 1.00

Actions
Explode to envelopes ===
Explode to linear =>>

Show Decomposed EN combinations  >>>

New Insert Edit Close
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To create a new combination, use the [New]-button:

EN-5LS Characteristic
EM-5LS Frequent
EM-5LS Quasi-permanent

Combination - MyCombil X
Contents of combination List of load cases
=4 Load case
& LC1 - Self weight

Name: MyCombil Delete Add
Coeff : 1 Correct Delete All Add All
Type: EN-5LS Quasi-permanent #

Envelope - ultimate

Envelope - serviceabili
Description ©  Linear - serviceability !g

EM-ULS [STR/GEC) 5et B

EM-ULS [STR/GEQ) 5et C

EM-Accidental 1

EN-Accidental 2

EN-Seismic OK Tl

This window contains two lists with load cases. The left list contains the content of the combination you are
making, the right list contains all available load cases. You can add a load case by double-clicking in the
right list of with the buttons ‘Add’ and ‘Add All’. After setting the load cases you should set the type of

combination.

3.3.1. Linear combinations

A linear combination is a combination completely defined by yourself. It is a single combination with the

selected load cases in it and with coefficients that you set.

Choose the linear combination type (ultimate or serviceability):

Name: MyCombil
Coeff : 1 Correct
Type: Linear - ultimate NG

Set the coefficients:

# " Combinations

ULS-Set B (auto)
SLS-Char (auto)
5LS- to)

H-FERIFE &2 O nputcombinations

Mame MyCombil

Description

Type Linear - ultimate

New

Amplified Sway Moment method ne
4 Contents of combination

LC1 - Self weight [-] 1.00

LC2 - Perm [-] 1.00

LC3 -Var [-] 1.00

Insert Edit Delete

Close
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3.3.2. Envelope combinations

An envelope combination is a group combination. All possible combinations that can be generated, considering
the relations of the load groups, are within this one combination. You still need to set the coefficients.

Choose the combination type (ultimate or serviceability):

Name: MyCombi2
Coeff : 1 Correct
Type: Envelope - ultimate v

Set the coefficients:

New Insert Edit Delete

B Combinations X
H-fERIFE &2 O Inputcombinations v
ULS-Set B (auto) Mame MyCombiz
SLS-Char (auto) Description
AL i Type Envelope - ultimate
4 Contents of combination
LC1 - Self weight [-] 1.00
LC2 - Perm [-] 1.00
LC3 - Var [] 1.00
Actions
Explode to linear =>>
Close

If you want to see the contents of the ‘group’ combination press the ‘Explode to linear’ button. This will split

this combination in single ‘linear combinations’.
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3.3.3.

Eurocode combinations
A Eurocode combination is a group combination. The relations between the loads and the categories are

generated by using the data of the load groups.

The categories define the psi factors. They can be found in the Status Bar under the National Annex flag.

There you choose Manage annexes, and select the relevant national annex (EN 1990).

v O W e 2o e BB IR

E .

B Standard EN

This opens the code settings of 1990. Here you can find the table with the psi factors. You can edit the

values if needed.

== Manage annexes

Austrian ONORM-EN NA
Belgian NBN-EN N&
British BS-EN NA
Cypriot CYS-EN NA

Faark CER_ER KA

Maticnalannex Belgian NEN-EN NA
Show both the Default EN and NA methods
References
“ EN 1990: Basis of structural design
EM 1990 (Basis of structural design)

[=1- Belgian NEMN-EN NA
- Combination
- [STR/GEQ) alternative
-1~ Buildings
| - Combination setup
Psifactars
i “-Lload combination factors
EJ Eridges
E| Combination setup

S PR S

Name Belgian NBEN-EN NA
4 Combination

alternative EN 1990:6.4.3.2 (3)

P Combination setup

4 Psifactors EN 1990: Annex Al Table Al.1

Psi factors - buildings

© B o= e B W R

5

11
12
13
14

Load
CategoryA
CategoryB
CategoryC
CategoryD
CategoryE
CategoryF
CategoryG
CategoryH
Snow
Wind
Temperature
Settlements
Special loads during execution

Construction loads

B Manager far National annexes )
BEEREE - 0 =@ A v
Standard EN

Ok

Psi factors
x
Brid Pail Exis EN 1990: Apfiex B Table B3
0.7 0.5 0.3
0.7 0.5 0.3
0.7 0.7 0.6
a.7 0.7 0.6
1 0.9 0.8
0.7 0.7 0.6
0.7 0.5 0.3
(+] 1] o
0.5 (v] 0
0.6 0.2 Q
0.6 0.5 o
1 1 1
2 1 0.2
1 0 0.2 gt

To create a Eurocode combination, select the type EN-ULS or EN-SLS:

Name: MyCombi3
Coeff : 1 Correct
Type: EN-ULS (STR/GEO) Set B
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The coefficients cannot be edited. They will be loaded automatically to the load case in the combination.

8" Combinations X
H -fEBIFE <« 2 [ Inputcombinations v
ULS-Set B (auto) Name MyENCombi
SLS-Char (auto) Description
5LS-Quasi (auto) Type EN-ULS (STR/GEO) Set B
MyENCombi T
Structure Building
Active coefficients
4+ Contents of combination
LC1 - Self weight [-] 1.00
LCZ - Perm [-] 1.00
LC3 -Var [] 1.00
Actions
Explode to envelopes ===
Explode to linear >>>
Show Decomposed EN combinations  *>>
New Insert Edit Delete Close

If you want to see the content of the ‘group’ combination press the ‘Explode to linear’ button. This will split
this combination in single ‘linear combinations’.

New Insert Edit Delete

8" Combinations X
=5 HFEBME &2 [ Inputcombinations v
ULS-Set B (auto) Name MyENCombi
5LS-Char (auto) Description
SLSQuasi (auto) Type EN-ULS (STR/GEO) Set B
; Structure Building
MyENCombi2 Active coefficients
MyENCombi3 4+ Contents of combination
MyENCombi4 LC1 - Self weight [-] 1.00
MyENCombis LC2 - Perm [-] 1.00
MyENCombi6 LC3 -Var [] 1.00
MyENCombiT
Actions
Explode to envelopes ===
[ Explode to linear >>>
Show Decomposed EN combinations  *>>
Close
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3.4. Nonlinear combinations

To perform a nonlinear calculation, nonlinear combinations should be added. You can add a nonlinear
combination via the Main Menu - Libraries > Load cases, combinations.

Nonlinear combinations - NC1 X
Contents of combination List of load cases
=@ Load case

@ LC3-Var

@ LC1 - Self weight

@ LC2-Perm
Name: NC1 Delete Add
Coeff : 1 Correct Delete All Add All
Type: Ultimate v
Description :
Bow imperfection None A
Global imperfection None b4 Stage for composite analvsis

OK Cancel

As in the ‘Combination’ window, you need to select the load cases that should be assigned to the nonlinear
combination. A nonlinear combination is a single combination, comparable with a combination of the type
‘Linear’. You define the type of the nonlinear combination: ‘Ultimate’ or ‘Serviceability’. At last, a bow and/or
global imperfection can be defined. This is only necessary when you perform a second order calculation.

8" Monlinear combinations X

HRFE «2 @O A v Y
Name NC1

Description

Solver index (0]
Type Ultimate "3
Stage for composite analysis mod Automatic v
4+ Contents of combination
LC1 - Self weight [-] 1.00
LCZ - Perm [] 1.00
LC3 -Var [] 1.00

Bow imperfection None v
Global imperfection None v
New from combinati...| Mew Insert Edit Delete Close

In this window you can set the coefficients and edit the imperfections.
There is also a function to automatically create nonlinear combinations from the combinations menu. This can
be executed with the button ‘New from combination’.
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Make selection % X
Tvpe of Linear v
Used filter
Available Selected
MyENCombi3 MyENCombil
MyENCombia MyENCombi2
MyENCombis =
MyENCombié
MyENCombi7 ==
MNonlinear 2
Create class
OK Cancel

Choose the type of combination (linear or envelope) and select the combinations you want to turn into

nonlinear combinations.

3.5. Result class

In a result class you can put multiple combinations.

In the ‘Result’ menu you will see the envelope of these combinations when asking for the result class. Result

classes can be found.

Result classes can be found via the Main Menu - Libraries - Load cases, combinations.

*

ULS-Set B (auto) - EN-ULS (STR/GEQ) Set B

Linear -
Linear -
Linear -
Linear -
Linear -
Linear -

Linear -

B Result classes
BEiEIFE «» O Al vy
Name AILULS
AlLSLS Description
W
MyENCombi -EN-ULS
MyENCombil -
MyENCombi2 -
MyENCombi3 -
MyENCombid -
MyENCombi5 -
MyENCombi6 -
MyENCombi7 -
New Insert Edit Delete

(STR/GEOD) Set B
ultimate
ultimate
ultimate
ultimate
ultimate
ultimate

ultimate

Close
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3.6. Point force

You can define loads via the Input Panel using workstation Loads.
You can choose from three types of point loads.

3.6.1. Point force in node
=  INPUTPANEL _ E_ Loads v

| POINT LOAD IN NODE stegories | & Aitags v
R R AR
S AgTld 4FPRFaE
« " AR ™

You can only place this point force in nodes. You can set following options:

B ' Point force in node x
Name F1
Direction Z b
Type Force "
Angle [deg]
Value - F [ki] -1.00
4 Geometry

System GCS v
0K g Cancel | 3
=1

« Direction: defines in what direction the force works.

« Type: the standard type is ‘Force’. You can change it to ‘Wind’ or ‘Snow’. If you change it to wind or
snow, the way the option ‘Value’ is determined changes.

» Angle: the point force can be given an angle. This is done by filling in a value for Rx, Ry, Rz.

. Ri90,Ry90 Re90
* Value: define the magnitude of the force.

» System: defines if the direction is following the global axis (GCS) or the local axis (LCS).
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3.6.2. Point force on beam
= INPUTPANEL | ﬂ_ Loads
| Poi_ﬂuomou 10 yries v .@ Alltags
A I C A T A R
e dgsld dFrdFa
« "B AW

You can place this point force along the length of an element.

B Point force on beam b
Mame Fb1
Direction Z v
Type Force v
Angle [deg]
Walue - F [kN] -1.00
4 Geometry
Extent full v
System GCS v
Coord. definition Rela v

Position x 0.000

Origin From start v

Repeat(n] 1

Fe
P ] : (I"I _1) « AX 4 Eccentricity
" X Eccentricity ey [m] 0.000

Eccentricity ez [m] 0.000

oK Cancel

With:
« Extent: definition on the full length of the beam or per span.
« Coord. Definition: define the position relative (value between 0 and 1) or absolute (value in m).
« Origin: definition from the start or the end of the element.

* Repeat (n): repeat the point force. If value is higher than one, you should define a distance between
point forces.

« Eccentricity: gives the point force an eccentricity.
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3.6.3. Free point force

INPUT PANEL
REE POINT LOAD |

A

T

I B O A

>R SFid Al BT

« " A R @

& Loads v~

You can only assign a free point force to a 2D member. You must define the geometry in the XY-plane of the
current UCS. When you draw the force, it only has an X and Y coordinate. It will be generated on every 2D
member that has a point that has this X and Y coordinate. This means that if you have a plate above this point

force the force will be generated on this plate as well.

3
|
v

5

> -

R Free point force

BV —2024/06/03

4 Geometry

Name FF1
Direction Z
Type Force
Value - F [kN] -1.00
Validity All
Select Auto

System GCS

. 0K Cancel |
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With:

» Validity: this setting has an influence on the generation. You can set it to ‘All’, ‘Z+’, °Z-* or ‘0. This

means that the

loads will

be generated on all the members or the members with a

positive/negative/zero Z coordinate. When the option ‘Select’ is defined for the property ‘Select’, the
loads will only be generated on the elements which are selected after executing the command ‘Update
2D members selection’ in the tab ‘Actions’.

» Select: there are 2 options: ‘Auto’ and ‘Select’. ‘Auto’ means the load is generated on all members.
‘Select’ means you should select the members to generate the load on.

To view an example of the generation you can select the load and press ‘Generate loads’ in the property

panel.
ACTIONS 33>
() Generate loads

To switch the view from the generated loads to the original loads, or the other way around, you can delete the
generated load OR right click > View parameters for all > Loads/masses

View parameters setting

Lock position

B Point forces
Free

B Line forces
On beam

B Labels of loads
Display label
Name
Value
Tot, value
Eccentricity label

4] W structure  [EEllabels [ElModel [Elloads/masses [ESteel [E|Connections “f~Composite [ Modelling/Drawing @9 Attributes  PPIMisc.  [&]View 3
[®] Check / Uncheck all
[ Service
Display on opening the service v
[ Display loads
Display v
style Colour by action type |
Load case LC3 - Var 5|
Display eccentricity
Generators Generated I~ Lz

Original
Original - Generated

<

IR

Show names in tab

Apply Cancel
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Loads

The following pictures provide a graphical representation of all the different validities which can be chosen.
Select = Auto, Validity = All
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3.7. Line force

You can add three types of line forces: ‘on beam’, ‘on 2D member edge’ and ‘free’.

= INPUT PANEL & Loads

E All categories @ All ta LINE LOAD ON 1D
by e @ g St |y D
s dSaslid 4F 8P
® A R m

= INPUT PANEL & Loads

E All categories @ All tags| LINE LOAD ON 2D EDGE
L s g M oAl D
s dSasld 4P FeE
® A R m

= INPUT PANEL | oads

E All categories @ Alltags FREE LINE LOAD
i L s @ . M af AL
T T e )_:i [l }3 )
« " A R®

The settings for line forces are the same as for point forces. The only extra setting is the length of the line
force. This can be set to relative (value between 0 and 1) or absolute.

4 Geometry

System LCS v
Location Length

Extent full v

Coord. definition Rela v

Position x1 0.000
Position x2 1.000

Origin From start v

3.8. Surface load

Next to point forces and line forces there are also surface loads. You can choose between two types of surface
loads: ‘on 2D member’ and ‘free’.

= INPUT BANEL | ads

= All categories -~ @ All tags

& |SURFACELOADON2D (@ 5 4f 14 uf i gy &
L “’:\ﬁé :r .Qrul ci Il' @ '.T:C‘ =
« A [l

= INPUT PANEL | oads v

= All categories @ All tags

& iy FREESURFACELOAD 5 _if i# Lf

& & 4 o =1 =& &b 45 |'s $ = -
< AR

The settings are the same as for the load types above.
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Chapter 4: Calculaton

41. Mesh

As default setting, a 1D element consists of 1 mesh element and a 2D element has an average mesh
element of 1m.

You can change these settings in Main Menu - Tools - Calculation & Mesh OR when starting the
calculation.

B Mesh setup X

Mame MeshSetupl
Average number of 1D mesh elements on straight 10 members 1
Average size of 1D mesh element on curved 1D members [m] 9,200
Average size of 2D mesh element [m] 0,500
Connect members/nodes
Setup for connection of structural entities

P Advanced mesh settings

L L

57 FE analysis X

4 Mesh setup

Average number of 1D mesh elements 1

Calculations

Linear analysis

Load cases: 1 Average size of 10 mesh element on cu 0,200

Average size of 2D mesh element [m] 0,500
Connect members/nodes

Setup for connection of structural entit

Other processes

Engineering report regeneration

Engineering reports: 1

Save project after analysis P Advanced mesh settings

4 Solver setup
Specify load cases for linear calculatior
Specify combinations for linear stabilit
Specify combinations for nonlinear sta

I Advanced solver settings

4 Engineering report

Specify reports for regeneration

Calculate

This setting has an influence on the accuracy of the results and on the speed of the calculation.

The mesh can be viewed by either going to ‘Set view parameters for all’, after right mouse click in the graphical
screen, or by going to the Viewbar = Other options > View settings for all entities. Then select:

e Structure tab > Mesh -> Draw mesh
» Labels tab > Mesh - Display label
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4.2.

Calculation / Solver

You can start the calculation either by clicking on the calculation shortcut in the Process Toolbar,

or via Main Menu - Tools - Calculation & Mesh - Calculate mesh,

CALCULATE

'E?;ms ‘

or by using the Ctrl-Shift-F5 shortcut.

FE analysis

Calculations

Linear analysis
Load cases: 1

MNonlinear analysis
Monlinear combinations: 1

Linear stability
Stability combinations: 1

Menlinear stability
Monlinear stability combinations: 1

Other processes

Engineering report regeneration
Engineering reports: 1

Save project after analysis

Calculate

Fl

Fl

[

Fl

Mesh setup
Average number of 1D mesh elements: 1
Average size of 10 mesh element on cu 0,200
Average size of 2D mesh element [m] 0,500
Connect members/nodes
Setup for connection of structural entit
I Advanced mesh settings
Solver setup
Specify load cases for linear calculatior
Specify combinations for nonlinear cal
Specify combinations for linear stabilit
Specify combinations for nonlinear sta
Advanced solver settings
Engineering report

Specify reports for regeneration

In the top left you can choose desired type(s) of analyses by checking/unchecking the boxes.

NOTE: you can turn on the option ‘Connect members/nodes’ so the program will automatically
execute this function before starting the calculation.
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Chapter 5: Results

5.1. Requesting results

After you perform the calculation, then the Results will be available in the Main Menu. You can ask for the
following results:

I I~

Ié Calculation protocol

ﬁ’_’ Nodal displacement
£5! 30 deformations

{all 3D stresses

| L8! Animation window

Supports
1D members

20 members

v v v w

Storeys

& Bill of material
' Thickness of slabs

51.1. Calculation protocol

In the calculation protocol you can check the equilibrium between the inputted loads and the acting reactions.

Calculation protocol

Linear calculation

Number of 2D elements 150
Number of 1D elements 107
Number of mesh nodes 196
Number of equations 1176
Bending theory Mindlin

Load cases BG1, BG2

Start of calculation 19.11.2018 00:50
End of calculation 19.11.2018 00:50

Sum of loads and reactions

Load case Value X Y 4
[kN] [kN]  [kN]

BG1 loads 0,00| 0,00| -1795,51
reaction in nodes 0,00/ 0,00 1795,51
reaction on lines 0,00/ 0,00 0,00
contact 1D 0,00 0,00 0,00
contact 2D 0,00| 0,00 0,00

BG2 loads 0,00 0,00 -300,00
reaction in nodes 0,00 0,00 300,00
reaction on lines 0,00| 0,00 0,00
contact 1D 0,00| 0,00 0,00
contact 2D 0,00| 0,00 0,00
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5.1.2. Nodal displacement

This result gives you the displacement and rotation of all the nodes in the structure. This is the purest result
out of the FEM analysis.

Uy,

5.1.3. 3D Results

There are two types of 3D results: ‘3D displacement’ and ‘3D stress’. In order to generate these results, the
1D results of 1D members and 2D results of 2D members are converted to 3D results. This is done with
transformation formulas. These results are not calculated in the calculation by the solver but are generated by
the post processor. Due to this transformation, the generation of results may take some time, depending on
the size of the structure (and the refinement of the mesh).

5.1.4. Results per component

For each component there is an item in the result menu: supports, beams (1D members) and 2D members.
For each of these components there are detailed results available. These results are calculated during the
calculation by the solver and take no additional time to generate. The difference with the 3D results is that
these results are viewed in 1D for beams and in 2D for 2D Members.

\
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5.1.5. Bill of material

In the bill of material, you will find information concerning the mass, surface and volume of the used materials
in the project.

Bill of material

Selection: All
Type of sorting: Material

Summary

Material Mass Surface Volume

[kgl [m?] [m°]
Steel 183028,2 | 353,413 | 2,3316e+01
[Total | 183028,2] 353,413[ 2,3316e+01 |

Note: Value 'Surface' represents for 1D members the total exposed surface area,
while for 2D members it corresponds only to the surface area of the centroidal plane.

Steel (1D)
Pe A ace 0
5235 7850,0 | 6403,2 | 203,413 | 8,1570e-01
[Total | | 6403,2| 203,413| 8,1570e-01
Steel (2D)
Material Density Mass Surface Volume
[kg/m?3] [kgl [m?] [m3]
S 235 7850,0 | 176625,0 | 150,000 | 2,2500e+01
[Total | | 176625,0] 150,000 2,2500e+01 |
5.1.6. Thickness of slabs

This function allows you to show a graphical representation of the thicknesses of all 2D elements in your model.
With the ‘drawing setup 2D’ you can chose between different lay-outs of which ‘thickness of slabs’ which
generates a colour for each individual thickness. If you would chose for ‘Smooth’ for example, a gradual legend
will be applied to show the thicknesses. This last option is automatically used whenever there are elements in
the selection with a variable thickness.

3
3
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51.7. Setting the properties menu

After you selected a result type, you need to set some parameters in the property panel. As an example, the
property panel of the ‘2D internal forces’ will be taken. Other results have similar options in the property panel.

n <

RESULTS (1) A

Name 20 internal forces
~ SELECTION
Type of selection  All v

Filter No
w RESULT CASE
Typeofload Combinations
Combination  ULS-Set B (auto) ~/
Envelope (for 2D drawing)  Absolute extreme v
Averagingof peak () )
Location In nodes avg. on macro
System  LCS mesh element
Extreme Global
Type of values  Basic magnitudes
Values m_x
w OUTPUT SETTINGS
Print combination key (
Standard result @Y
Results on sections @
Resultsonedges () )

p TABLE SETUP

» ERRORS, WARNINGS AND NOTES SETTINGS
ACTIONS 33>

@ Refresh

(®) New combination from Combination key

@ Drawing setup 20

@ Praview

« Type of selection: view results on the complete structure or on a selection of it.
« Filter: filter on material, wildcard, layer or thickness.
« Type of load: choose the load case, combination or result class.

* Envelope: show maximum, minimum or absolute extreme values. Absolute extreme show you the
biggest absolute value.
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Location: the finite elements mesh in SCIA Engineer exists of linear 3- and/or 4-angular elements.
Per mesh element 3 or 4 results are calculated, one in each node. When you ask for the results on 2D
members, the option ‘Location’ in the property panel gives you the possibility to display these results
in 4 ways.

(¢]

In nodes, no average

All result values are considered, there is no averaging. In each node are therefore the 4 values
of the adjacent mesh elements shown. If these 4 results differ a lot from each other, it is an
indication that the chosen mesh size is too large. This display of results therefore gives you a
good idea of the discretisation error in the calculation model.

12 | 16 24 | 30

9118 250 a0

" 16 74 | 2%

9|17 24 | 32
In centres

Per finite element, the mean value of the results in the nodes of that element is calculated.
Since there is only 1 result per element, the display of isobands becomes a mosaic. The
course over a section is a curve with a constant step per mesh element.

21

In nodes, average

The values of the results of adjacent finite elements are averaged in the common node.
Because of this, the graphical display is a smooth course of isobands.

In certain cases, it is not permissible to average the values of the results in the common
node:

= At the transition between 2D members (plates, walls, shells) with different local axes;

= [faresultis discontinuous, like the shear force at the place of a line support in a plate.
The peaks will disappear completely by the averaging of positive and negative shear
forces.

BV —2024/06/03 75



Basic Concept Training - SCIA Engineer 24

(e]

In nodes, average on macro

The values of the results are averaged per node only over mesh elements which belong to
the same 2D member and which have the same directions of their local axes. This resolves
the problems mentioned at the option ‘In nodes, average’.

14 | 14 25 | 28
4] 14 28 | 28
13]13 272
13113 27 | 27

» System: direction according to: ‘LCS of the mesh’ or ‘LCS of the element’.

« Extreme: you can set this setting on ‘Global’, ‘Member’ or ‘Mesh’. ‘Global' means that only the
maximum value of the complete model is shown. For ‘Member’ the maximum per member is shown.
For ‘Mesh’ the maximum per mesh element is shown.

* Type of values: there are three types of values: ‘Basic magnitudes’, ‘Principal magnitudes’ and
‘Design values’.

(¢]

76

Basic magnitudes = Characteristic values

= Beams 1D
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= Bending (plates, shells)
» Bending moments mx, my
7P

my

y

- D
m // ¥
) /// -
//J
e
f m, =-— ch.z dz
P —
b2 m, =-— LGY'Z dz
e Torsion moment mxy
g
// P
7 my, ¥
o ~
e
/ Q My, == 12 dz

» Shear forces gx, qy (=vx, vy)

=

-~
-
e
-
s

qx=—‘Lﬂ:m dz

//
e \L WV aq--[r,
3 U

= Membrane effects (walls, shells)

e Membrane forces nx, ny

7P

¥
o >
o nJ’
XP/// nx :LGX dz
n, n, =Lcy dz
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»  Shear force gxy (=nxy)

zP

qu=LTw dz

o Principal magnitudes

The principal magnitudes give the results according to the axes of the directions of the largest
stresses (principal directions). These directions are defined with the help of the Mohr’s circle.

AT

Tmax

Txy

_Txy

o Elementary design magnitudes = Design values

To derive the dimensional magnitudes from the basic magnitudes, formulas of the Eurocode
are used:

x | —".)'I for { = | 11)’|

o

,\'y
]

0 for m, <m, andm, < —|mx).|

m, >m, and my = —|mxy|

m, + for m, > m, andm, < —Imxy|

design moment in direction of local axis x for reinforcement on negative
surface

< m, and - ,
m, + |7nxy| for {mx < my, andm, = |mx,|

2
m3,

e

0 for m, < my, and m, < —|m

m, >m, andm,, = —|m,‘.,.|

m, + for m, > m, and my, < —|mxy|

]
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MyD+ design moment in direction of local axis y for reinforcement on positive
surface
m, <m, andm, = —|m
m, + |mxy| for { * Y * | x’l
m, >m, andm, = |m,‘,|
17'!2
m, +—— | | for m, >m, andm, < —|m,,y|
)
0 for m, < m, and m, < —|mx,.|
myb design moment in direction of local axis y for reinforcement on negative
surface
m, <m, andm, = —|m
m, + |mx),| for{ v * | x’l
m, >m, andm, = |mu|
17'!2
m, +—— | | for m, > m, andm, < —|m.\.,.|
)
0 for m, < m, andm, < —Imn.I
MeD+ complementary design moment in the concrete on positive surface
m, <my and m, = —|mvy|
—2|myy| for
m, >m, andm,, = —|m,,|
m2,
m, — ﬁ for m, <m, and my, < —|m,,|
X
m;
m 2 for m, >m, and m, < —|m
v xy
[my|
MecD- complementary design moment in the concrete on negative surface
) oo ™ < myand my = —|myy|
~2fmyy| for m, >m,andm, = —|m,,)|
x v v = xy
mZ
m, — |n:y for m, <my and m, < —|m,,|
X
2
my, — —= for m, >m, and m, < —|m,,|
[my|
NxD design force in x direction
) n, <n,andn, = —|n
n, + |"xr| for { * i * | x)l
n, >ny,andn, = |n,_‘|
+— for n, > ny andn, < —|nu|
|".\ |
0 for n, < ny, andn, < —|nx_‘.|
nyp design force in y direction
_+| |f- x Snyandn, In |
My My T n, >ngandn, —Innl
nZ,
A <n, — |y
n, + N for n, < nyandn, < |nx,|
0 for n, > n, andn, < —|nx>.|
Ned design force in concrete

n, <nyand ny = —|[N,,,
—2|nyyl for{ = * Iy
n, >nyand ny, > —|n |

—In.| -

nZ,
—= for n, < ny and n, < —|ny|
Ingl
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» Drawing setup 2D: In this window you can configure how you want to see the results (isobands,
isolines, numbers, ...). You can also set a maximum and minimum value.

2D results display

| DispLAY

Isobands

Minimum and maximum settings ..

One colour

"

54

Smooth
Isolines

Ground value

Usevalue 0

Local extrems
None

Stule

Sy

Labelled isolines
Numbers

3 colours

3 colours with numbers

_—
TS

Advanced settings ..

Sy’

Automatic palette values - roundec ¥

Cancel

Isobands Numbers

~ : ~
R IR B Q9 e

5.2. Results table

You can also ask for the results in a table. You can open the results table by clicking on the ‘Results table’ in
the property panel.

ACTIONS =
4 Refresh Fs
() New combination from Combination key

() Drawing setup 2D

@ Results table

T] Report preview

RESULTS TABLE ™ o o [@J S =AY f  H1] | intemal forces; Linear calculation; Combination: CO1; Extreme: Global; Selection: All;Location: In nodes avg, on macro. System: LCSmesh element b 4
4 Name Mesh x[m] y[m] z[m] Case mx[kNm/m]  my[kNm/m]  mxy[KNm/m] v [kN/m] vy [kN/m] x [kN/m] ny [kN/m] oy [kN/m]

1 51 Element: 1661; Node: 11 10,000 7,000 4,000 o1 -52,08 112,82 086 214,51 251,79 590,52 6423 -1142

2 51 Element: 509; Node: 579 1,250 2250 4,000 coy/2 16,28 5023 -0.20 -0,07 509 86,86 -30.14 463

3 s Element: 1661; Node: 11 10,000 7,000 4,000 foeit | 5200 -112,88 089 21490 251,82 589,56 64,28 -1095

4 51 Element: 660; Node: 732 15,000 2,750 4,000 co1/3 020 55,23 2,87 -167 040 164,80 <030

5 51 Element: 1680; Node: 12 15,000 7,000 4,000 Co1/4 -28,54 96,50 -20,43 258,76 319,68 5293 129,01

€ s1 Element: 1621; Node=9 0,000 7,000 4,000 col/4 -28,16 95,12 19,99 255,90 314,24 114,00 -109,92

7 s Element: 5620; Node: 18 5,000 28,000 4,000 coys 519 112,00 100 -276,68 %142 500,29 63,17 1859

8 |s1 Element: 5641; Node: 19 10,000 28,000 4,000 co1/2 | 5192 -112,00 0,96 276,57 251,45 590,66 63,05 | 1873

9 S1 Element: 1660; Node: 11 10,000 7,000 4,000 o -50,60 112,45 <135 -253,98 -252,37 s 61,04 3049

&8 Dinternal forces - Basicm...

80

BV —2024/06/03



5.3. Results preview
You can view the results as well in the preview. The preview shows you the table that is generated by the
engineering report.
|  ACTiONS

&% Refresh F5

@ Mew combination from Combination key

() Drawing setup 20
| @) Resultstable
T] Report preview

2D internal forces

Linear calculation

Combination: CO1

Extreme: Global

Selection: All

Location: In nodes avg. on macro. System: LCS mesh element
Basic magnitudes

mx Mxy Vx nx Nxy
[kNm/m] [kNm/m] [kN/m] [kN/m] [kN/m]

Vy Ny
[kN/m] [kN/m]

E1l Element: 1 0,000 |CO1/1 -280,65 -40,44 | 682,47 11,63 4,66
Node: 1 0,000 -78,80 164,53 2,59
3,000
El Element: 5 5,000 [CO1/1 194,45 0,00 0,00 2,00 0,00
Node: 180 0,000 4,42 9,82 -0,05
3,000
E1l Element: 20 10,000 |CO1/1 13,08 5,18 -50,14 0,15 0,01
Node: 33 2,000 64,26 24,57 -2,21
3,000
EL Element: 8 8,000 |CO1/1 87,99 -42,57 | -187,51 4,30 -0,08
MNode: 136 0,000 §,62 27,47 0,22
3,000
EL |Element: 2 2,000 (CO1/1 87,99 42,57 187,51 4,30 0,08
Node: 66 0,000 6,62 27,47 0,23
3,000
E1 Element: 41 0,000 |CO1/1 -208,87 39,17 545,00 6,42 -3,45
Node: 5 5,000 -194,48 -319,78 2,75
3,000
E1l [Element: 101 10,000 |CO1/1 -208,87 39,17 | -545,00 6,42 -3,45
Node: 8 10,000 -194,48 319,78 2,75
3,000
E1l Element: 1 0,000 |CO1/1 8,72 -15,27 | -249,11 -4,26 -1,47
Node: 57 1,000 42,68 107,95 -3,30
3,000
E1l Element: 51 10,000 |CO1/1 -200,42 36,89 -542,29 6,76 -3,74
Node: 6 5,000 -192,12 293,27 3,27
3,000
E1l Element: 10 10,000 [CO1/1 -280,65 40,44 | -682,47 11,63 -4,66
Node: 2 0,000 -78,80 164,53 2,59
3,000

Name Combination key
Coy1 1.35"BG1 + 1.50*"BG2

5.4. Section on 2D member

You can find the ‘Section on 2D’ command in the Calculation & Results workstation of the Input Panel:

= INPUT PANEL | @ calculation &Results

= All cata SECTION ON 2D | & All tags

I@xﬁwﬁﬁnu

8 Section on 2D member X

Name SE1
Draw Z direction v

Direction of cut [m] 0.000/0.000 / 1.000
Layer Layerl v,
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+ Draw: determines the direction of the result which is drawn on the section.

« Direction of cut: defines the direction of the cut that will be made by a vector X/Y/Z. For example,
0/0/1 is a cut in the Z direction.

To view the results on the section you need to check the ‘Results on sections’ in the property panel when you

ask for a result.
w QUTPUT SETTINGS
Print combination key
Standard result

Results on sections

0880

Results on edges

=

2
L

: W
L
x

5.5. Averaging strip

An averaging strip averages peak values over a zone.

You can find the averaging strip in the Calculation & Results workstation of the Input Panel:
= INPUT PANEL 8  Calculation & Results

= All categories - AVERAGING STR‘"’ﬁ All tags

BNBreoafa

i RS X

Name RS1

Type Point v
Width [m] 1.000
Length [m] 1.000
Angle [deg] 0.00

Direction longitudinal v

» Type: you can choose between a point or a strip.

« Dimensions: here you need to set the dimensions of the point/strip.
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+ Direction:

1) Direction = Longitudinal

i
% 20 wemal forces
unew clcionen
Lond case- L2

Seiechon: A1

o magntutes
Etreme” Gibal

-LLJ»;LLJ»A»/L}A\}.

20 intermal forcns.

e calctenen
Lod cane 12

k-

ARz B
Seiecron: A1 =
L e e

fgsbEEEEEcEEEs

m fm /m)

SEEEELEERELSESEEs

Longitudinal means that the averaging is done in the longitudinal direction of the strip. In the
example above this is the y-direction. This means that the averaging is done for my. The values

my are averaged in the x-direction.

2) Direction = perpendicular

BV —2024/06/03

Lo nose:
LG5 mesh dement
Bnac magraies
Eatreme: Giobal

P S N N N

Perpendicular means that the averaging is done perpend
strip. In the example above this is the x-direction. This means that the averaging is done for mx.
The values mx are averaged in the y-direction.

icular to the longitudinal direction of the
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3) Direction = Both

3
H
2
i

i

NP T

A e T e W S P s

—

22
R

Both means that the averaging is done in both directions of the averaging strip. This means the
values are averaged for mx as well as my in the direction perpendicular to mx and my.

To activate the averaging strip you need to check the option ‘Averaging of peak’ in the property panel.
w RESULT CASE -
Typeofload Combinations -

Combination ULS-Set B (auto)
Envelope (for 20 drawing)  Absolute extreme
Averaging of peak | @Y)
Location  In nodes avg. .cm macro
System  LCS mesh element
Extreme  Global ~~
Type of values  Basic magnitudes ~~

Values m_x v
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5.6. Integration strip / integration member

An integration strip is a strip which is defined on a 2D member. On this strip you can ask results as if it is a

1D member.

An integration member works in 3D, so the results on multiple 2D members will be given on the strip as if it is

a 1D member.

You can find both functions in the Calculation & Results workstation of the Input Panel:

INPUT PANEL

T

\N®+ &0 o

| = INPUT PANEL | =
B All categories | INTEGRATION MEMBER 5gs

EETIY I

Set the width of the integration strip:

E Calculation & Results ~~
All categog INTEGRATION STRIP | | & Altags ~

Calculation & Results

i Integration strip

BV —2024/06/03

Name CM1
20 member 51
Create meshnodes no
Effective width definition Wickth
Effective width geometry Constant symmetric
Width (total) [mm] 1000.0

OK

C

ancel
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Go to Main Menu > Results > 1D Members - Internal forces, and check the option ‘Integration

strip/member’:
| = RESULT CASE

Typeofload Load cases v

Load case  LCL - Self weight

@

Integration strip/member

i 1D internal forces
Values: N
Linear calculation
Load case: BG2
Coordinate system: Principal
Extreme 1D: Global
Selection: CM1

3

The workflow is similar for an integration member.

In the integration member window, you can set the shape, dimensions and buckling data of this member.

i’ Integration member

4 Bounding box

4 Rectangular integration shape

4 Buckling

Name IM1

Shape Rectangle

Left [m] 0.500
Right [m]
Bottom [m]
Top [m]

0.500
0.500
0.500

Betayy 1
Betazz 1
Member type Beam
Cross-section C51 - Rectangle (400; 300)
Integration relative to position of Center of gravity
Number of sections 10
Selection of members for integration All
LCS standard
LCS Rotation [deg] 0.00

Layer Layerl

*

L

OK Cancel
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Chapter 6: Steel design

This chapter describes the most important functions and features needed to perform a design on steel
members and connections.

6.1. Steel setup

You can open the steel setup by going to Main Menu -> Design > Steel members > Settings.

B Steel setup >
[=- Belgian NBN-EN NA Name Belgian NBN-EN NA ~
=) Steel
. Fl
[ Member check Sl
Fire resistance 4 Member check EN 1993-1-1
- Cold Formed 4 Classification EN 1993-1-1: 5.2.2
- Plated structural elements N s
- Limit slenderness AL v

- Buckling defaults Plastic analysis Elastic Stresses v

- 5LS deflection check Stability classification method Utilisation factor n v
- Autodeston 4 Shear EN 1993-1-1: 6.2.6
Use Ay, A, instead of elastic shear yes
4 Torsion EN 1993-1-1: 6.2.7
Limit for torsion [-] 9.05
4 Default sway types EM 1993-1-1: 6.3.1
¥y yes
ZZ e
4 Buckling length ratios ky, kz EN 1993-1-1: 6.3.1

Max. k ratio [[] 10.00
Max. slenderness [] 1000.00

2nd order buckling ratios Acc. to input v

4 Lateral Torsional Buckling EN 1993-1-1: 6.3.2
Lateral torsional buckling curves Rolled section or equivalent welded ¥
Methed for C1 C2 C3 ECCS 119/Galea v
Methed for k,_ Determined from C1 v

4 General settings
Elastic verification no
Verifv onlv section checks no e

Load default non-MA& parameters Load default NA parameters Cancel

In this window you can change the general settings. These settings have an influence on the checks. By
default, these settings are according to the Eurocode. You can find more detailed information about this
menu in the steel manual.

You can overrule the settings in the steel setup for one (or more) member(s) by assigning ‘Steel member
data’. If you choose this option, a window will open where you can assign these settings to individual
member(s).

= INPUT PANEL & steel

| STEEL MEMBER DATA ategories | @ mitgs

L'f;f'ﬂ > i H

BV —2024/06/03 87



Basic Concept Training - SCIA Engineer 24

6.2.

Buckling settings

You have several ways to determine the buckling factors. The first option is to leave everything by default
and let SCIA calculate the buckling factors. A second option is to assign buckling groups to members to
guide the determination of the buckling factor.

6.2.1.

Default buckling calculation

When you use this method only one adjustment needs to be made. In the steel setup you need to set the

default sway type.

B Steel setup

[=J- Belgian NBM-EN NA
(- Steel

Fire resistance
Cold Formed a
i Plated structural elements

- Limit slenderness
- Buckling defaults
i SLS deflection check

o Autodesign
i

a

4 Member check

Mame Belgian NEN-EN NA

4 Steel

EN 1993-1-1
Classification EN 1993-1-1: 5.2.2
Use Semi-Comp+ yes

Plastic analysis Elastic Stresses

Stability classification method Utilisation facter n

Shear EN 1993-1-1: 6.2.6
Use Ay, A, instead of elastic shear yes
Torsion EN 1993-1-1: 6.2.7

Limiifaciocion L] 008

4

EN 1993-1-1: 6.3.1

Default sway types

¥y Bl ves

z-z no

AL CEE D o L ey
Max. k ratio [-] 10.00
Max. slenderness [[] 1000.00
an order buckling ratios Acc. to input

Lateral Torsional Buckling EN 1993-1-1: 6.3.2

Lateral torsional buckling curves Relledsection or equivalent welded ¥

Method for C1 C2 €3 ECCS 119/Galea
Method for k_ Determined from C1
General settings
Elastic verification no

Verifv onlv section checks no

Load default non-NA parameters Load default NA parameters

]

Eance)

With these settings it is determined if the structure is sway or not (braced or not) around the strong (y-y) and
weak (z-z) axis of the profiles in the structure. Depending on this setting a different formula is used to
determine the buckling factor:

4 for a non-sway structure:
(p1p2+5p1+5p2+24)(p1p2+4p1+4p2+12)2

(2p1p2+11p1+5p2+24)(2p1p2+5p1+11p+24)

« fora sway structure:

k=x

with the
the
the
the
the
the

the

2

T +4

p1x
buckling factor
system length
modulus of Young
moment of inertia
stiffness in node i
moment in node i
rotation in node i

4p1p, + Py

X =
n2(p; + pz) +8p1p,

_CL-L
pi = El
M;

C: = —
o
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The values for Mi and @ are approximately determined by the internal forces and the deformations, calculated
by load cases which generate deformation forms, having an affinity with the buckling form. So, when

performing a linear calculation, then 2 additional (hidden) load cases are calculated, just to calculate the
buckling factors for the elements.

This calculation is automatically done when calculating the construction linearly.

NOTE: when calculating nonlinear, you should also perform a linear calculation otherwise no buckling
factors are calculated, and no steel code check can be performed.

The following loads and load cases are considered in the linear calculation for the calculation of the buckling
factors:

* loadcase 1:

o onthe beams, local distributed loads qy = 1 N/m and gz = -100 N/m are used;

o onthe columns, global distributed loads Qx = 10000 N/m and Qy = 10000 N/m are used.
* load case 2:

o onthe beams, local distributed loads qy = -1 N/m and gz = -100 N/m are used;

o on the columns, global distributed loads Qx = -10000 N/m and Qy = -10000 N/m are used.

The used approach gives good results for frame structures with perpendicular rigid or semi-rigid beam
connections. For other cases, you must evaluate the presented bucking ratios.

The system length of every buckling system is automatically determined by SCIA Engineer. All elements (with
the same cross-section, ...) that lie on the same line are — by default — in the same buckling system. The
buckling system can be split up in multiple systems when there is a support or a member perpendicular on the
member in the direction of the strong or weak axis. The buckling system is only shortened for the relevant axis.

Vs

)

Ay

r\ A AN N

BV —2024/06/03 89



Basic Concept Training - SCIA Engineer 24

6.2.2.

Assign buckling groups

To have more influence on the determination of the buckling factors, you can assign buckling groups to
members. You can use the same buckling group for members that have the same buckling system (same
length and buckling supports).

To create a buckling group for a member, select the member and press on the manage-icon next to the
‘System lengths and buckling settings’ property in the property panel.

Name

Layer

Type

Analysis model
FEM type
Cross-section
Alpha [deg]
Member system-line at
ey [mm]

ez [mm]

LCS

LCS Rotation [deg]

¥ BUCKLING
Systemn lengths and buckling settings

Material and no. of parts
Secondary member

¥ GEOMETRY
Length [m]

Shape

Bl

Layerl ~
column (100)
Standard ~~
standard
Cs2 - IPE240
0.00

Centre

0.00

0.00

standard

0.00

Default

o

B Systern lengths and buckling settings

FFlETsE A

(]
/)

Settings  Results
Name BG1

Buckling span

et
zz= zz ¥
ye= 2 N
ITB= zz ¥

B Active buckling constraints

4 Spansettings

Buckling lensth factors
lev factor

Swav v-v

Member imperfection in 2nd order analvsis

Bow imperfection e.v

b Advancedsettings

O X
Deflection span
Deflectionz = Ny RN
Deflection y = -z v
Settines per span for
Calculate v Sway y-y
1
From setup v
From setup v
Save Cancel
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« Buckling constraints: you can set the buckling constraints by clicking on the triangles or by opening
the active buckling constraints and checking/unchecking the boxes. Adding a constraint shortens the
buckling system.

4 Active buckling constraints

vy zz

» Sway setting: you can determine if the structure is sway or not along the active axis by clicking on
the green line or by changing the ‘Sway’ setting. A cross means non-sway and a double arrow means
sway.

Swav v-v From setup A N N

From setu,
Member imperfection in 21 oy syay P

All non-swa
Bow imperfection e0.v @

k2 b

« Buckling span: this setting determines what axis you are changing (strong or weak).
Buckling span

Sy

2-2= 2z V¥

» k-factor: the k-factor can be calculated by SCIA Engineer as explained above, can be set by you or
the buckling length can be set by you. When you choose ‘factor’ or ‘length’ the value can be changed
in the table next to the setting.

Buckling leneth factors Settines per span for v-v axis
kv factor Factor I} A ky [-] Sway y-y
Calculate 1 1.00
Swav v-v
Length 2 1.00

Mambhar fmmmacfasdinm im da T aednr Amakorin

After setting the buckling group you need to press [Save]-button to apply it to the member. The property now
changed in the property panel. You can assign it to other members with the same buckling system. The
buckling group overwrites the settings for buckling (default sway) in the steel setup.

w BUCKLING

System lengths and buckling setting o=

Material and no. of parts b

Secondary member } )
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6.3. Steel member data

There are some effects that cannot be considered in the model that have an influence on the check. You can
take this into account by adding ‘Member check data’. This is data that has only an influence on the check.
These elements are not ‘physically’ added to the model and have no influence on the internal forces.

The following member check data will be discussed in this course:
LTB Restraints, Steel (web) stiffeners and Sheeting.

6.3.1. LTB restraints

Via the Input Panel:
= INPUT PANEL &= steel
‘S'EI. LTE RESTRAINTS @ Alltags

¥ [Te: =i H

The LTB (Lateral Torsional Buckling) length can be shorter than determined by SCIA Engineer. This is
because members are connected by their centre lines, or because some elements are not modelled. An LTB
restraint is model data added to a beam to change the LTB length of this beam. The new LTB length is the
distance between the added LTB restraints.

B LTB Restraints X

Name LTB1
Positionz +Z v
Fully restrained
4 Geometry
Coord. definition Rela v

Position x 0.000
Mumber of LTB restraints (n) 1

OK 5 Cancel

You need to set the position (top or bottom of the member) and the location of the restraints.
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6.3.2. Steel stiffeners
Via the SCIA Spotlight:

I Steel stiffeners

L

Stiffeners increase the shear area of a section. This is advantageous for the shear check. This model data is
added because it is not possible to ‘physically’ model the stiffener. This is because a member (beam/column)
is a 1D member and thus has no surface.

B Stiffener *

Mame Sti
=D Material S235 v ...
D Thicknessimm] 20 v
ll =D Decrease [mm] 1
Rigid end posts
D E P
4 Geometry
Coord. definition Rela v
Position » 0.000

Number of stiffeners (n) 1

OK Cancel

To add a stiffener, you need to set its geometry, material, and position.

6.3.3. Sheeting
Via the Input Panel:
= INPUT PANEL & steel -
A STEEL SHEETING @ niwgs v

I Lﬁ’i =i H

Usually, the sheeting is not modelled. This is because the assumption is made that for a steel hall the
complete load is transferred to the 1D structure. To take the stiffness of the sheeting + the effect on the
calculation of Mcr into account without changing the standard assumption, this model data can be added.
B ' Sheeting x

@~ s

Ny @ Shesting LIE Sheetl ¥
Positionz *Z
/ k land2spans
= Shesting position Pesitive

Bolt position Top flange
Bolt pitch br
Lf - frame distance [m] 3-000
Ld - sheeting length [m] 1.000

£ el e | €

4 Geometry
Coord. definition Rela v
Position x1 @000
Position x2 1.000

Origin Fromstart v

oK Cancel

You need to set the parameters of the sheeting and its location.
NOTE: you can find more information about the member check data in the steel manual.
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6.4. ULS Check

You can find the ULS check in Main Menu - Design > Steel members after calculating the project.

@ © o ‘a
- Steel members
Aluminium
Timber

Concrete settings
Concrete 1D
Concrete 2D

Please click here ¢

i f§© settings

> ':\ Slenderness

» | 1T ULScheck

» | ) S5LScheck

Graphically it gives you the highest unity check (from all checks performed) per section of a member. You
can perform a section check and a stability check. All checks are performed according to the Eurocode. Next

to the graphic output you can also open the preview to see more detailed results.

=

RESULTS (1)

A X

Name [EC-EN 1993 Steel check ...

| v SELECTION
Type of selection

Filter
Results in sections

w RESULT CASE
Type of load

Combination

¥ EXTREME 1D
Extreme 1D

Type of values
Values
Interval

¥ QUTPUT SETTINGS
Qutput

Print combination key
P DRAWING SETUP 1D

All
No
All

Combinations

ULS-Set B (auto)

Global
Overall Unity Check

overall check

QO

Brief

(9]

P ERRORS, WARNINGS AND NOTES SETTINGS

ACTIONS 35
Z ¥ Refresh

(3®) New combination from Combination key

(3® Autodesign
(3) Results table

T Report preview

94
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6.4.1. Graphic output

To view the graphic output, you need to set the property panel correctly. Most of the settings are the same

as in the ‘Results’ menu.

« Type of values: you can choose between ‘overall unity check’, ‘section check’ or ‘stability check’.

» Values: you can view the overall check (from the setting above) or a single check.

= RESULTS (1) A X
Name EC-EN 1993 Steel check ULS
¥ SELECTION
Type of selection  All b
Filter No
Results in sections  All G
~ RESULT CASE
Typeof load Combinations
Combination ULS-Set B (auto) v
¥ EXTREME 1D
ExtremelD  Global
Type of values  Section check s
Values >
Wtrvat I Section Class
+  Tension
w QUTPUT SETTINGS Compression
Qutput | Bendingy
Print combination key | Bendingz
i\ Sheary
» DRAWING SETUP 1D | shearz
» ERRORS, WARNINGS AND NOTE! Torsion

ACTIONS 3%
' Refresh

(® New combination from Comb

(® Autodesign
() Results table

T Report preview

After setting the property panel, press

i

Combined Shear y Torsion
Combined Shear z Torsion
Web Crippling

Bending and Reaction
Combined Axial, Bending, S...
Chord as beam

Purlin Resistance

Refresh’ on the bottom of the property panel.
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6.4.2. Preview

After setting the property panel and refresh you can press the preview button to see the output generated by

the engineering report. This contains more detailed tables.

You have three output levels: ‘Brief’, ‘Summary’ and ‘Detailed’:

w OUTPUT SETTINGS

output [FE
b DRAWING SETUP 1D I Brief Ls

b ERRORS, WARNINGS AND N¢|  Summary

ACTIONS 55 | Detailed

When the detailed output is selected, you can set this output to view tables with the calculated values, to

view the formulas or to view both.
¥ QUTPUT SETTINGS

Output Detailed
Components [FLD

Print decision table || Tables

Formulas
» DRAWING SETUP 1D

[,
g

Tables and formulas

Below you can see an example of the detailed output with tables and formulas:

Compression check

According to EN 1993-1-1 artide 6.2.4and formula (6.9)

A 5,3800e-03 [m?
Nese 1264,30 kN
Unity check 10,02

Axf,  5.3800-10-*[m?) x 235,0[MPa

Nepa= —= 1264, 30[kN]

T 1,00

Ngg |~24,17[kN]

fniv.ck
Unity.check= &= 1264, 30[kN]

0.02 < 1,00

Bending moment check for My

According to EN 1993-1-1 artice 6.2.5 and formula (6.12),(6.13)

Wy 5,7500e-04 [m?*
Moiyae 135,13 kNm
Unity check 0,61
W, x f, 5,7500 - 10-¢[m?] x 235.0[MPa]
T 1,00
M, g4 82, 71[kNm]
Mg, pa  135,13[kNm]

Moy e

Unity check 0,61<1,00

96

135, 13[kNm]

EC3-1-1: 6.10

(EC3-1-1: 6.9)

EC3-1-1: 6.13

EC3-1-1: 6.12
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6.4.3.

Table output

Lastly you can view the results in the table output. When you double click on a row in the table the preview of
this row is previewed. In the top you can set the output level (summary or detailed).

ACTIONS =3
¥ Refresh

(®) New combination from Combination key

() Autodesign

| @ Results table

' TJ Report preview

RESULTS TABLE
4 Name
1 Bl
2 B4
< B5
4 B8
5 B9
6 B12

dx [m]
0,000
0,000
0,000
0,000
0,000

0,000

Case

€o1/1
co1/1
Co1/1
€o1/1
co1/1
Co1/1

F5

Cross-section

CSTE
CSIE
CSIE
CSTE
CSIE
CSIE

HEA340
HEA340
HEA340
HEA340
HEA340
HEA340

™ '_‘;. .‘n ..'. maln Summary ~

Material
5235
S235
S5
5235
S235
S5

UCOverall [-]
0,37
0,67
0,71
1,22
0,37

0,66

UCSec[-]
0,02
0,07
0,04
0,13
0,02

0,07

B 1] | ECEN 1993 Steel check ULS;... | X

UCstab [-]
0,37
0,67
0,71
1,22
0,37

0,66

B 77 77 77 ECEN 1993 Steel check UL... A~
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6.5. SLS Check

You can find the SLS check in Main Menu - Design - Steel members after calculating the project.

@ © I ‘a

Steel members

Steel connections
Geotechnics
External tools

El Check manager

You can choose between the overall unity check or a specific value for Y or Z direction.

¥ EXTREME 1D
Extreme 1D

Type of values
Values
Interval

Coordinate system
w DUTPUT SETTINGS

Print combination key

¥ DRAWING SETUP 1D

Display value name

Display values

Display units
Display case
Display section dx

Display combination key

4 ' Settings

4 'l Slenderness

» | {7 ULS check

¥ |,{)_ SLS check |

Global

Deformation u_z

uz,max
uz,var
Camber dx uz
Camber
Lim. uz,max
Lim. uzvar
Check uz,max
Check uz,var
Check uz
uz,max,rel
uz,var,rel
Camber dx uz,rel
Camber,rel
Lim. uz,max,rel
‘J:rir_nr._ uz,var,rel

o

* u,tot or u,var: the relative displacement of each member for the total load or for the variable part of

the load.

« Camber: the camber over the length of the element (dx uz) or the maximum camber over the entire

element (uz,max).

Lim. u,tot or Lim u,var: the limit of the relative displacement L/x for the total load or for the variable
part of the load. You can set x-value in the steel setup or on element level in the ‘system lengths and
buckling settings’. You can set the value for the camber there as well.

E-B_elg\an MNBN-EN NA
[=- Steel

a
i~ Member check S
i~ Fire resistance P Member check
i~ Cold Formed P Fire resistance
i~ Plated structural elements o
o Limit slenderness ColdFormed
- Buckling defaults I Plated structural elements
SL5 deflection check b Limit slenderness
- Autodesign
P Buckling defaults
4 SLS deflection check

4 S5LS deflection limits
4 In plane deflection (def z)

Total loads [-]
Variable loads [-]

4 Qut of plane deflection (def y)

Total loads [-]
Variable loads [-]

4 SLS camber

Camber definition

Name Belgian NBN-EN NA

EN 1993-1-1
EN 1993-1-2
EN 1993-1-3
EN 1993-1-5
EN 50341-1

200.00
360.00

200.00
360.00

No camber v

« Check: the relative displacement is compared with the limit. You can check the total displacement or
the variable part of the displacement or you can perform an overall check.
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6.6. General autodesign

You can access the general ‘Autodesign’ function via Main Menu - Tools - Calculation & Mesh:

A 949 © o fa

Calculation & Mesh » | calulate
Selections » | &% Hidden calculation

E;_i Autodesign |,\\,
BIM toolbox » (=] Solver settings

You can use the ‘Autodesign’ function to automatically receive an optimal unity check for the cross-sections
which are used in your project. You can perform a single autodesign by following the steps below.

The first step of the autodesign you create multiple cross-section lists. By applying this cross-section list, the
software is forced to only use the steel profiles that you have added to these lists, and we can avoid the use
of non-standard profiles such as for example an IPE4000 or a HE260AA section.

You can find the function ‘Cross-section list’ in the Main Menu -> Libraries - Structure and analysis.

I::-J % Please click here or press Space ar
£ Layers

£ Materials Ctrl+M

I Cross sections Ctrl+J

E Image gallery
@ Paperspace gallery

Load cases, combinations »

Loads »

Dynamics »

Structure and analysis 3 | Buckling groups

Tools » I Named item

Steel 3 [EJ Effective section properties
Concrete, reinforcement » I Cross section list

Prestressing » .* Fabricated CSS & product rat

After you have selected this function, the cross-section list manager will open, and you can create a new list
by selecting the button ‘New’. Afterwards you can define the type of cross-section list, for example a
cross-section list with only one type of steel profiles or a list with multiple types of profiles. In this example the
option ‘Library cross-sections of one type’ will be selected.

= ITEHFE «~ O =B A v Y
[ A HER0A Name Al HExxxA B
Sl Type of list Library one type
| AllHFLeq S
Form code name | section |
Code name HE
4 Iltems
Type of cross-section list x
|
Dimension list
| » Library cross-sections of o= type |
Library cross-sections of multiple types
|
=
Library section HE280A
Library section HE300A |
| Library section HE320A |
| Library section HE340A
Library section HE360A
Library section HE400A |
Library section HE450A
Vihrary cactinn HES00A b
New Insert Edit Delete Close
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After you confirm with ‘OK’, the profile library will open, and you can select the cross-sections which you want
to add to the list. In the following example, this will be done for HExxxA-profiles. After you have defined this
cross-section list, it will be added to the cross-section list manager. You can create multiple cross-sections
lists in one project.

Uik oFtavailable cross-satiions ¢ | | 7 tistsof available cross-sections x
HABIFE &2 O wB A vy
Form code Code name Selected to list AL HE o Name AllHExxxA
AllTPEo Thaeii Mrm e iom
| section CS(NBR) HE100AA All HFLeg Form code 1
'Rectanguiar NoNOW SEcion CE
Circular hollow section HE100B frmeztonrn Iet
L section HE100C Geizne
Channel section HE100M 4 ltems
T section HE120AA Library section HE100A
Full rectangular section Library section HE1204
Full circular section HE120B Library section HE140A
Asymmetric | section HE120C
Rolled Z section HE120M Library section HE1604A
Cold formed angle section HE140AA Library section HE150A
Cold formed channel sectio [HE140A | Library section HE200A
Cold formed Z section HL HE1408B Library section HE220A
Cold formed C section HL(SZS) HE140C Library section HE240A
Cold formed Omega sectior HM(CH) HE140M Libr tion HE260A
Cold formed C section eave: HN(CH) HE160AA ranysecien
Cold formed C-Plus section HP CEE Wy e M
Cold formed ZED section HP(ARQ) HE1608 Library section HE300A
Cold formed ZED section as: HP(ARCUS) HE160C Library section HE320A
Cold formed ZED section in: HP(GERD) HE160M Library section HE340A
Cold formed Sigma section HP(Imp) Library saction HE360A
coleformed ioma section gy BICH e Uerary secton HE00A
Library section HE450A
OK Cancel Iibrary sartinn HF5004
New | insert | Edit | Delete Close

When you select the function ‘Autodesign’ in the Main Menu - Tools - Calculation & Mesh, the autodesign
manager will open and you can define a new one. After you click on ‘New’ and on ‘Add item’, you can select

the option ‘Cross-section AutoDesign’ in the tab ‘Steel’.

Propertv

ftems.

| | Remove ftem | Add item |

Parami aqd item

Concrete

Member Design (AMRD)

oss-section AutoDesign
“Fire Resistance AutoDesign
Cortugated Web AutaDesign
Steel Connections
Bolted Diagonal AutoDesign
Timber
L.. Cross-section AutoDesign
Aluminium
L. Cross-section AutoDesign
Geotechnics
Pad Foundation AutoDesign

oK | cancel

X

Faloteagn| | Colcaaten

In the following step you should select and confirm the cross-section(s) which should be optimized.

Make selection ¢
Available Selected
cst
cs2
cs3
>
cs4
<«
<
Cancel

Close

In the following window ‘Overall Autodesign’, you can define the parameters for the design.
It is important that you select the correct type of loads for each cross-section in the autodesign. You can
perform the autodesign for a load case, for a combination or for a result class.
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You can select the defined cross-section lists as well when you activate the option ‘Use cross-section list
and then select the list in the tab ‘Filter list’.

You should define the maximum value for the optimized unity check with the option ‘Maximal check’.

You can modify these parameters for each cross-section that is mentioned in the window ‘ltems’.

The final step in this window is that you activate the command ‘Autodesign’ at the bottom of this window.

Overall Autedesign X
Property Parameters PICTURE
Name 01 Cross-section €51 -HE20 v
Type of loads Combinati v Parameter Em‘m v
Combinations CO1-ULS v Use cross-sectio J'
Autodesign typ: Steel - Cross Filter list All HExxxA v
ftems count 4 Sort by Height v

Starting C55 Actual v
Search pattern Findfirsto v
Direction Upanddoy v
tems IMa!imalcheck[ 1,00 I
Autodesign chee 9,00

2. €52 [IPE160)
3. C54 [HFLeqT0X70x7)
4,053 (IPE120)

Remove ltem Add item

Autodesign Caleulation Close

As soon as you have executed this final command, a summary of the autodesign will be displayed. This table
will provide you the optimized profiles as well as the optimized unity check.

Cross-section Parameter Sort by Filter list Original cross-section | Autodesign of cross-section | Autodesign check

G
CS1 - HE180A HE180A Height Al HExxxA | CS1 - HE200A CS1 - HE180A 083
C2 - IPE220 IPE220 Height Al IPExxx C2 - IPE160 C - IPE220 075
CS4 - HFLeq90x90@ |HFLeq90x90x9 | Height CS4 - HFLeq70x70x7 | CS4 - HFLeq90x90x9 079
CS3 - IPE140 IPE140 Height Al IPEXxxx CS3 - IPE120 CS3 - IPE140 072
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Within this command, you can perform an iterative autodesign as well. You can execute this by closing the tab
‘Overall Autodesign’ and selecting the command ‘Optim. Routine’ in the autodesign manager. After you
have selected this option, you can define the iterations of the design by a limit number of iterations or it can be
determined automatically. In this example the number of iterations will be set to 3. The autodesign of the

profiles will be executed after you have pressed on ‘Start’.

B Overall Autodesig %

H-EFE a2 O @B A ,7|

gL Name 01 A
Type of loads Combinations v
Combinations €01-ULS v

Autodesign type Steel - Cross-section AutoDe

Automatic Autodesign routine x

Set number of Autodesign iterations

v

O Determine automatically
(®) Limit number of iterations

New Insert Edit

Delete

Optim.Routine  Autodesign all | Calculate | Close

As soon as the iterations are finished, you will get an overview of all the routine steps as well as the
optimized profiles and unity checks.

1. Routine step: 1
1.1. 01

Cross-section Parameter Sort by | Original cross-section | Autodesign of cross-section | Autodesign check
G|
CS1 - HE140C HE140C Height [ CS1 - HE200A CS1 - HE160C 052
CS2 - IPE2000 IPE2000 Height |CS2 - IPE160 CS2 - IPE2000 086
CS4 - HFLeq90x90@ |HFLeq90x90x@ [Height |[CS4 - HFLeq70x70x7 | CS4 - HFLeq90x90x9 079
CS3 - IPE140A IPE140A Height [ CS3 - IPE120 CS3 - IPE140 072
2. Routine step: 2
Cross-section Parameter Sort by | Original cross-section | Autodesign of cross-section | Autodesign check
Gl
CS1 - HE140C HE140C Height |[CS1 - HE160C CS1 - HE140C 061
CS2 - IPE2000 IPE2000 Height |[CS2 - IPE2000 CS2 - IPE200 099
CS4 - HFLeq90x90@ |HFLeq90x90x@ |[Height |[CS4 - HFLeq90x90x9 | CS4 - HFLeq90x90x9 095
CS3 - IPE140A IPE140A Height [CS3 - IPE140 CS3 - IPE140A 099
3. Routine step: 3
Cross-section Parameter Sort by | Original cross-section | Autodesign of cross-section | Autodesign check
G|
CS1 - HE140C HE140C Height CS1 - HE140C CS1 - HE140C 054
CS2 - IPE2000 IPE2000 Height |CS2 - IPE200 CS2 - IPE2000 085
CS4 - HFLeq90x90@ |HFLeq90x90x9 |[Height |[CS4 - HFLeq90x90x9 | CS4 - HFLeq90x90x9 098
CS3 - IPE140A IPE140A Height | CS3 - IPE140A CS3 - IPE140A 097
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6.7. Connection check

To create a connection in the ‘Steel’ menu you should activate the functionality ‘Steel connections’:
Project data X

Basic data Functionality Actions UnitSet Protection

GENERAL
Property modifiers
Model modifiers
Parametric input
Climatic loads m
Mobile loads
Dynamics
stability [
Monlinearity ftﬁ
Structural model :.’E
IFC properties
Prestressing
Eridge design
Construction stages

DETAILED
Support nonlinearity/basic soil s Q "
Initial imperfections
Geometrical nonlinearity
General plasticity
Compression-only 20 members
Cables
Friction support/Seil spring
Membrane elements
4 Subsoil

Soil interaction
Pad foundation check

4 Steel

Plastic hinge analysis

Fire resistance checks

Steel connections E’; I

Scaffolding W

OK Cancel

To add a connection to your model, use the Input Panel:

INPUT PANEL & stee|

FRAME STRONG-AXIS

vEx

After you have selected a connection type, you should choose the node where you want to add the
connection. In this example a strong-axis connection is chosen. After you have chosen the node, the
following label will appear on the node:

All categories v

I @ > Ed

[Conn[Nz]}

NOTE: you can create the connection only if the members have the correct type. A column should
have the type ‘column’ and a beam the type ‘beam’ (see chapter 1D elements).

When you select the label, you can define the connection in the property panel:
w SIDE ->[B3]
Connection type  Frame bolted ~~
Endplate @) =
Backing plate ()
Tophaunch () )
Bottom haunch () )
Bolts @@~ =
Top stiffener  (J )
Bottom stiffener ()
Diagonal stiffener () )
Web doubler ()
Update stiffness () )
Calculation type  Internal forces
Output  Summary
Length for stiffness classifica... 3.00

w STIFFENERS
Between bolt-rows 12

() 7}
Between bolt-rows 23 CD
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To create the connection, choose the connection type and check the components of the connection. To edit
the components, press on the manage-icon next to the component.

57 End-plate X
il Name EP
Material $235 v o
Thickness[mm] 10 v
= Input Top/Bottom/LeftiRight v

Top extension [mm] -5
Bottom extension [mm] 20

Left extension [mm] ©

Right extension [mm] 0
Total width [mm] 120
Total height [mm] 255

OK Cancel

51 Bolts X

Selected bolt assembly M5 - 4.6 (IS0 4014, 1t v ... A

I Length [mm] 35
= Bolt pattern 2 bolts/row v
L Reference Bottom of the beam

Internal bolts distance [mm] 66

Use lat bolt-row for shear capacity only
1.Row

2.Row

3.Row

4.Row

5.Row
Actions

Update location  »>>

OK Cancel

When you have defined the connection click on the ‘Refresh’ button at the bottom of the property panel. The
preview window will automatically open. In the preview window all the strength checks according to the
Eurocode will be performed.

IRESULTS:..

Unity checks

My Ed/Mi,y Rd 3.18
Mz,Ed/Mj,z,Rd 0.05
NEd/Mj,Rd 0.04
vz,Edvz,Rd 1.39
Vy EdVy Rd 0.00
Vz,Edfvz,Rd + Vy,Ed/Vy,Rd 1.39
My, EdMj,y,Rd + Mz EdMjz,Rd [3.23

You can get a more detailed view by changing the output type in the property panel.

Calculation type  Internal forces

oupur SR
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Next to the strength check, a stiffness check is performed as well. In the main model a stiffness is assumed
for each node. This stiffness is fully fixed or the stiffness of a hinge that is added to the node. The stiffness
assumed in the project should be checked with the connection that you just have created. If the stiffness of the
connection does not lay between certain boundaries (so that it can be assumed to be the same as the stiffness
in the model), then the stiffness in the model should be adapted. In this example the stiffness of the connection
(in blue) does not lay between the boundaries (a stiff node is assumed).

MNm

0.0600,

rad

0.0005)
0.0010,
0.0015)
0.0020,
0.0025)

0.0

You can do this automatically by checking the option ‘Update stiffness’. When you have checked this option,
a hinge will be added to the node after calculating the project another time. This hinge has the real stiffness of
the connection.

Update stiffness | 8~

NOTE: when the stiffness is updated the internal forces are different as well. This means that the ULS
and SLS checks of the beams are different as well.
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Chapter 7: Concrete design

7.1. Concrete setup
You can open the concrete setup by going to Design > Concrete settings = Settings.
Concrete settings O >
Views: Complete setup ¥ |View settings w | | Load default Find National annex -
Description Symbaol Value Default Unit Chapter Code Structure  CheckType
<all> B2 calls 2 <all> Pl O <. O <all> O <all> Ll <an> O] <a> 0O

I Design defaults
4 Solver setting
> General
Intemnal forces
Design As
Conversion to rebars
Interaction diagram
Shear

(-3

-3

(=4

(=3

(-4

[ Torsion

[ Punching
[ Stress limitations
(=g

(-4

(=3

-3

Cracking forces

Crack width

Deflections

Detailing provisions =

0K Cancel

In this window you can set all concrete settings. This contains the design defaults (reinforcement, concrete
cover), settings for the recalculation of internal forces and code-based settings. You can find a complete
explanation of all these settings in the concrete manual.

The settings done in the concrete setup are done for the whole project. You can change these settings also
for only one member by using the option ‘Setting per member’. This option will open a window where you can
change the settings and assign them to a selection of members.

INPUT PANEL
LL] SCIAcatalog

E Concrete o

= All categories -~

@ All tags

v COMCRETE ADDITIOMAL DATA

Vi &

7.2. Recalculated internal forces

For the concrete design recalculated internal forces are used. Following modifications can be applied. You can
find this table in the concrete settings menu.

4 Solver setting
4 |nternal forces

Shear force reduction above supports 6.2.1(8) EM 1992-1-1
Moment reduction above supports 5322 4) EM 1992-1-1
Shifting of moment curve to cover additional tensile force cause.. 9.2.1.3(2) EM 1992-1-1
Geometric imperfection in ULS i ULs 5.2(2) EM 1992-1-1
Geometric imperfection in SLS 855 5.2(3) EM 1992-1-1
Minimum eccentricity Emin In first order ec.. In first ord... 6.1(4) EM 1992-1-1
First arder eccentricity with the equivalent moment 5.8.8.2(2) EM 1992-1-1
Second order eccentricity ez 538 EM 1892-1-1

> Internal forces modifications
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Shear force/Moment reduction above supports

yeo [ LI = ™ B e

" A N
AL ‘IH

B :

You can view the values for the recalculated internal forces with Design - Concrete 1D - Internal forces
for design. You can view the normal internal forces (N, M, V) as well as the recalculated internal forces (Ned,

Med, Ved).

.

X
Shift rule

This option takes an extra tensile force caused by shear by shifting the moment line into account:

O

v

10: a;= Coeff,-d - {cot B~ cotea) f 2
20 a=d
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Geometric imperfection
This option adds a geometric imperfection:

O s,-0

g 0:=6;- o - @,

Minimum value of eccentricity
This option takes a minimum value for eccentricity into account:

A) No eo=ete;
e=eggte;

B) Min. ecc. to first order ecc.
ep=max(es+e;;€omin)

e=gpte;
C) Min. ecc. to final ecc.
e,=e,+g
e= max( (:-.[)"'82;e£)minjI
€omin=max(h/30;20mm)
First order eccentricity with equivalent moment
This option calculates an equivalent first order moment for the whole member instead of having different
values:

Mug = D,G " an + 0,4 " Mﬂl E 0,4 " Muz

Second order eccentricity
This setting takes the second order effect into account:

109
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7.3.

Provided reinforcement

Before you calculate the theoretical reinforcement, you can add a template of reinforcement to your element(s).

You can use this template to:

. compare the template with the calculated theoretical reinforcement. By doing this, you can easily
see where this basic template is not sufficient;

. convert to user feinforcement (only for 1D members), perform the punching design and crack
width check (only for 2D members) and calculate the code dependent deflections.

The reinforcement added by the template is called ‘Provided reinforcement’.
To add ‘Provided reinforcement’, go to Design = concrete settings > Settings. This example is for a 2D
member. The workflow is the same for 1D members.

Concrete settings m} x
Views: Design defaults ¥ | View settings Load default Find National annex: n
Drescription Symbal Value Default Unit Chapter Code Structure CheckType
<all> S <alz O <all> Ll <aiz O] <. O] <all> O] <all> | <all> 0| Design. %
4 Design defaults
4 Reinforcement

- Beam / Rib

> Beam slab

P Column

4 Plate

4 Longitudinal
Design of provided reinforcement Independent |Plate Shel
@em Plate BasiCuw .. IF‘Iat e_Basic Independent |Plate Shel
4 Upper (z+) -
Type of cover Typees Auto Auto 441 EM 1992-1-1 |PlateShel..| D
Diameter of first layer ds1+ 10,0 mm EM 1992-1-1 |PlateShel..| D
Angle of first layer direction o+ 0,00 deg EM 1992-1-1 |PlateShel.| Dt
Diameter of second layer ds2+ 10,0 mm EM 1992-1-1 |PlateShel.| Dt
Angle of second layer direction 02+ 90,00 90,00 deg EM 1992-1-1 |Plate5hel..| D¢
4 Lower (z-)
Type of cover Typee- Auto 441 EM 1992-1-1 |Plate5hel..| Dt
Diameter of first layer ds1- 10,0 mm EM 1992-1-1 |PlateShel..| D»
Angle of first layer direction - 0,00 deg EM 1992-1-1 |PlateShel..| D»
Diameter of second layer ds2- 10,0 mm EM 1992-1-1 |Plate,Shel..| D+
Angle of second layer direction - 90,00 deg EM 1992-1-1 |Plate,Shel..| D+
4 Shear
OK Cancel

Click on the 3 dots next to the ‘Design template of provided reinforcement’. This opens a window with all the

default templates.

8" Provided reinforcement (design)

H LB o
1 Plate_Basic_AddList_All
Plate_Basic_Lower
Plate_Basic_Both
Plate_Basic_Add_Lower
Plate_Basic_Add_Both
i e e e -
Mame Plate_Basic_AddList All
Basic and list additiona
Plate, Sheli(Plate)
Rectangle
Standard

==

Description
Member type
Cross-section

Mode

Insert

New Edit

ok |

110
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You can select one of these templates, make a new one or edit one of the existing templates. Select the first

template and click on ‘Edit’.

Provided reinforcernent (design) edit - Plate_Basic_AddList_All O e
Member type Flate Shell(Plate Longitudinal reinforcement
Cross-section By || dly
Made Standard
Definition of Basic reinforcement: By Diameter v
Basic reinforcement Additional reinforcement
Layer Diameter Spacing Area Type Diameter Spacing Area
[mm] [mm] [mm *2/m] [mm] [mm] [mm*2/mj}
List by spaci.. 100 0:100;1502.. (/78552

[t+] 10,0 200 333
-] 10,0 200 393
[ 10,0 150 524
124 10.0 150 524

List by spaci.. 18.0
List by spaci.. 10,0
List by spaci.. 10:0

01001502,
0:100:1502..

01001502 07

OK

In this window you can define the reinforcement. There are 2 types of reinforcement in templates:

. Basic reinforcement: this type of reinforcement is added over the entire plate.

Cancel

. Additional reinforcement: this type of reinforcement is only added in zones where, according to
the calculated theoretical reinforcement, extra reinforcement is needed. You can define a single
diameter and spacing as extra reinforcement or a list of reinforcement with either various

diameters or various spacings.
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7.4. Required reinforcement

You can find the required reinforcement under Design - Concrete 1D/2D - 1D reinforcement design/ULS
& SLS reinforcement.

7.41. 1D members
In the menu ‘1D reinforcement design’ you have 2 types of values:

* Required: these values represent the theoretical reinforcement calculated by SCIA Engineer. The
following required values are available: As,req (amount of longitudinal reinforcement), Aswm,req
(amount of shear reinforcement) and Aswm,req(¢) (same as Aswmreq but the value is displayed in
diameters).

2

770 mm
N
% 8/33
L\
*\\
@8/141mm, (ns=2)

e T

2

424 mm”™

M
N Ly,

Lﬁ X ]_(»X
» Provided: the provided reinforcement can be viewed in two different values as well: As,add,req and
As,prov.
As,prov is the provided reinforcement defined in the template.

402 mm”2

79 mm 12

402 mm”2

N

5

I—> X

As,add,req is the reinforcement that is needed on top of the provided template according to the
theoretical design. This means if the required value is higher than the provided value it can be seen in

this view.

368 mm~2

22 mm”™2

—~7
=
4

>
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7.4.2. 2D members
In the menu ‘ULS & SLS reinforcement’ you have 4 types of values:

* Required: these values represent the theoretical reinforcement calculated by SCIA Engineer. This
takes into account the detailing provisions.

4 9. Detailing of members and particular rules
[ 9.2 Beams
4 9.3 Solidslabs

4 9.3.1Flexural reinforcement

Check max. bar distance =T WA EM 1962-1-1
Check min. reinforcement area 93111 EM 1962-1-1
Checlk max. reinforcement area 93111 EM 1962-1-1
Check min. ratio of principal reinfarcement 921101 EM 1962-1-1
Check max. ratio of principal reinforcement 921101 EM 1962-1-1
Check min. transverse ratic of secandary reinforcem... 9.3 1102 EM 1962-1-1
Check max.spacing of principal longitudinal reinforc... 9.2.1.1(3) EM 1962-1-1
Check max.spacing of secondary longitudinal reinfor... 9.2.1.1(3) EM 1962-1-1

4 9.3.2 Shear reinforcement

Check min. ratio of shear reinforcement EN 1962-1-1
Check min. thickness of member with shear reinforce.. EN 1962-1-1
Min. thickness of member with shear reinforcement | hy, 200 mim EN 1962-1-1
Check max. spacing of shear links EN 1962-1-1
Max. spacing of shear links Coeffsmay p.s| 0:8 EN 1962-1-1
i
-
E
¥ -~
~
361 £
£
330 =
1
300 =
]
270 {
2490
210
180 .
150
120
90
a0
30
0

As,req1+: theoretical required reinforcement on the top side of the plate (positive Z direction) in the
first reinforcement direction. Taking into account the detailing provisions.
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Required (statically): these values represent the theoretical reinforcement calculated by SCIA
Engineer without the detailing provisions taken into account.

As,stat1+: theoretical required reinforcement on the top side of the plate (positive Z direction) in the
first reinforcement direction. Without taking into account the detailing provisions.

Required (additional): these values show if there is extra reinforcement needed on top of the provided
reinforcement. Areas where this value is 0 are areas where no extra reinforcement is needed

(compared to the provided reinforcement). Areas where these values are not 0 are areas where the
provided reinforcement is not sufficient.

Constant walug 0

As addreql+ [m m2/m 1

As,add,req1+: theoretical additional required reinforcement on top of the provided reinforcement on
the top side of the plate (positive Z direction) in the first reinforcement direction.
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« Provided & User: these values show you the provided reinforcement which you have defined in the
templates, eventually together with the user reinforcement.

Reinfprov,1+

$10,0/200 + $10,0/100 (insufficient) i
$10,0/200 + $10,0/100
$10,0/200 + $10,0/150
$10,0/200 + $10,0/200
$10,0/200 | |

As,Provi+: provided reinforcement on the plate. If elements are red the reinforcement defined in the
template (and user reinforcement) is not sufficient.

7.5. User reinforcement

7.5.1. 1D members

In the theoretical reinforcement design, we have calculated where reinforcement is needed. It is possible to
convert the provided reinforcement directly to practical reinforcement. You can choose for the action
‘Conversion for real bars’ when you have chosen the option Design > Concrete 1D - 1D reinforcement
design and if you have generated the results for ‘Provided’ as ‘Type of values’ in the property window. Now a
window appears that mentions you if it was possible to convert into real bars or not. If not, some explanation
is given.

Afterwards you can edit the reinforcement by selecting the reinforcement data and choosing the action ‘Edit
reinforcement’.
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You can also input manually the practical reinforcement by adding ‘1D reinforcement’ for the whole length of
the beam.
You can first select a template for the longitudinal reinforcement:

i Longitudinal reinfercement *

Aia g BB v & =E
LR_B_R1
LR B_R2
LR C_R1
LR_B_R3
LR_B_R4

Mame LR_B_I
Description Long. r
Stirrup name Stirrup
Number of laye 2
Diameter [mm] 16,0
Area [mm~2] S04
Type of beam beams

e | msert | et | Dotk ok |

Next, you have to decide where the parameters of reinforcement are coming from:

Reinforcement parameters =

Do you want to use parameters of reinforcement [diameter of long.reinforcement, stirrup and concrete cover}

| : ' from the Concrete member data
i) from the Design defaults
@ from the defined template

Mote: Some Member data exists on beam, but they are not of expected type.

Now the practical reinforcement is shown graphically on the screen:
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Concrete design

As a user, you can add locally ‘New stirrups’ or ‘New longitudinal bars’.
For the stirrups, you can select a certain stirrup shape:

3 Stirrup shape manager X

AigemBik o & =FHE
StirrupRe
StirrupR10
StirrupR11
StirrupR12
StirrupR13

Chtevs D1 2

MName Stirrup
Description Stirrup
MNumber of stin 1
Diameter [mm §,0
Number of cut: 2

[ et | e | ]

You can edit the stirrup shape, or you can make a new one. Therefore, user points must be added.

Stirrup shape

Delete || Deleteall

Diameter [mm] 8,0
Number of vertex 4 '
Torsion [ yes

Shear in joint [ yes

Analysis model

SHEAR CALCULATION
Numba. Dfﬂm 5':':

STIRRUP USER DEFINED POINTS
st ltem-edge index Type  Rela  Abso[mm] ‘rom A — —
| Newstirrup "| : . Dk oimand, 25 0=
AllLomatie | PICTURE PROPERTIES
o B2 Draw intersection points
Diameter " Draw corners points
80 © mm- < P > Texts & Pointsscal 05 [
[_mea [ peme (| petmeall | || Redraw |

. oK || Cancel |
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For the longitudinal reinforcement, you can define precisely where you want to place the additional practical

reinforcement (with the cursor snap settings):

Point in 5/7 of length

368 mm*Z

The configuration for the selected zone of the member is shown:

LONGITUNIDAL REINFOR...

MNew layer

ik bagsiocctiess

| Bars positions
| COLLISION OF BARS

Ct;llision

"
z
f.—.‘i‘
3
N\ 1 7/
LI.

NEW REINFORCEMENT PARAMETERS

Number of bars Z ¥
Diameter [mm] 8.0 o
Stirrup name 51 e
Edge index 7 ¥

* Between existing bars
Move laver

TYPE OF BEAM

beams and ribs

| STIRRUPS
Edit stirrups
Edit cover

: Save to template

¥

Filter All
L1-51E4

¥

Delete

Name

Position numbe
Material
Diameter [mm]
Number of bar:
Area [mm*2]
Layer type
Cover fype
Cover [mm]
Left bar

Right bar

Delete all

L2-51E2 [l
3

B 500A v ...
16,0

2

402

Uniform v
Surface to v
0,0

Before the v

Before the v

(3 =

Analysis model Automatic design
REINFORCEMENT LAYERS AREA

Selected layers
All layers

402 mm”"
B804 mm*

PICTURE PROPERTIES
Draw dimensions

Textsscale

05 |*

Red;'aw

oK

Cancel
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Here you can set on which edge extra reinforcement needs to be added:

Member 54, Zone from 3,571 m to 6,425 m(0.357 - 0.643) x
Filter All 2
s | L1-51E4
= L2-51E2
s ® O
Delete Delete all
Mame L3-S1E2 ”
3 ]_ Position numbe 5

Material B 500A v ..,
Diameter [mm] 16,0
MNumber of bar: 2
] Area [mm*2] 402

Layer type Nocorner v
Cover type Surface to v
Cover [mm] 9,0
LS A =/ Stirrup name 51 ¥
Edgeindex 2 v

w

Analysis model  Automatic design

LONGITUNIDAL REINFOR... | NEW REINFORCEMENT PARAMETERS || TYPE OF BEAM REINFORCEMENT LAYERS AREA
Mumber of bars 2 v beams and ribs v Selected layers 402 rmm®
Diameter [mm] 16 v All layers 1206 mm®
Stirrup name 51 v STIRRUPS PICTURE PROPERTIES
Bars positions Ednsindes < 3 csfonitl Texir::a‘ll:lmensmnsﬁ,S ]
COLLISION OF BARS oy T

Collision Save to template

* Move laver OK Cancel

For reasons of simplicity, we will add 2 bars of 16 mm that are still needed over the whole area where extra
reinforcement is required. This can of course be done more detailed.
The same procedure will be repeated for the lower reinforcement (in between supports).

You also need to increase the shear reinforcement in the zone above the support. You can do this by increasing
the diameter of the stirrups or by decreasing the distance between the stirrups.
You can create different stirrup zones with the action ‘Edit stirrup distances’:

2x]1d8.0-0.090 2x10d8.0-0.258 2x31d10,0-0,100 2x10d8.0-0.277 2x[,1d8.0-0.099
0 0,050 0,129 0,005 0,005 0,004 0.004 0

Pﬁ%ﬁ 2,500 3,000 2.500 [D&?é
Zone 1 Winimum stirrup reinfarcement Teut scale = F
Zone Length[m] Diameter [mm] Distarce [m] Realdistance [m] Type By user Jistarce tobegin[m By user Distarce toend[m]
Zoned i3 [ 3,000 10,000 0.1 ] 0,100 single v yes v 0,005 no 0,005
Zone 5

Additional stirrup reinforcement

Symmetrical

Parts from both points
Input type Numbers Diameter [mm] Distance [m] Total distance [m] Type
Newz_or!e _D_er_etezqm_z | MNew part De_Le_t_e p_art_
oK Cancel
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7.5.2. 2D members

Next to theoretical required and provided reinforcement you have also practical or user reinforcement. You
can add this type of reinforcement to the 2D member via the input panel.

Mame RR1
2D member Slabl
4 Reinforcement

Type Bars »
Material B 500A v o

Surface Upper
Number of directions 2
Direction closest to surface 1 v
Angle of first direction [deg] 0,00

b =~ A 1
Diameter (dl) [mm] 12,0
@ ® ] % Concrete cover (cl,cu) [mm] 3@
.\ CIIT Bar distance (sl) [mm] 200
l sl l sl l @l Offset [mm] ©
Reinf. area [mm”2/m] 565
2
Total weight [kg] $3,90
4 Geometry
Geometry defined by Polygon v
Actions

Load from setup  >>>

oK Eandl

You have to add this reinforcement separately at the upper and lower side (each time with two reinforcement
directions).

NOTE: you can add multiple layers of practical reinforcement on the same area. The reinforcement
added to this area is the sum of all these layers.
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7.6. 1D ULS & SLS checks

The following checks are available for 1D Members in SCIA Engineer. Requesting output from these checks
is the same as in the ‘Results’ and ‘Steel’ menus and will not be explained in this chapter.
7.6.1. Capacity response

The ‘Capacity response’ check is based on the calculation of strain and stress in a particular component
(concrete fibre or reinforcement bar). The check consists of the comparison of those strains and stresses with
the limited values according to EN 1992-1-1 requirements.

Extreme values of stress/strain in component

Type of component Fibre/ = &n O Oiim UC[-] Status
Bar [%o0] [%e] [MPa] [MPa]
Concrete - compression 1 -163 -35 -187 -20 093 OK
Concrete - tension 3 264 0 0 0 0.00 OK
3
1

Reinforcement - compression -1.16 -225 -233  -454 051 OK
Reinforcement - tension 217 | 225 434 454 095 OK

7.6.2. Capacity Diagram

The ‘Capacity diagram’ service uses the creation of interaction diagram (graph presenting the capacity of a
concrete member to resist a set of N+My+Mz).

This check calculates the extreme allowable interaction between the normal force N and bending moments My
and Mz.

3D interaction diagram - Vertical section N-M,

3D interaction diagram - Vertical section N-M,..

z |
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7.6.3. Shear + Torsion

The check of the interaction between shear and torsion consists of three checks according to clause 6.1 - 6.3
in EN 1992-1-1:

. check of shear;

. check of torsion;

. check of interaction of shear and torsion.

Shear check

Check Vrgmax
Veg = 152 KN £ Vegmax + Veed + Vig = 598 kKN

{Note; The check satisfies for crushing of the compression strut (Vg £ Vagmax + Vig + Veca): ]

Check Vegmax
Veg = 152 KN < Vegmax + Veea + Vig = 705 kN

lNote: The check satisfies for shear force near the support (Vg € Vedmax + Vig + Veea). ’

Check Vrg and Vggys
Veg = 152 KN > Vog, = 87.8KN and Veg = 152 KN > Vig + Veeg + Vig = 66.5 kN

Error: The check does not satisfy, because of shear reinforcement (Veg > Vag + Vg + Vag). It is necessary to increase

area of shear reinforcement or to increase dimensions of the cross-section or quality of shear reinforcement.

Unity check
_abs(Ves) _ abs(152kN) _
e Vag s B6SkN - 228
7.6.4. Stress limitation

The stress limitation check is based on the verification of:

* compressive stress in the concrete: the high value of compressive stress in concrete could lead to
appearance of longitudinal cracks, spreading of micro-cracks in concrete and higher values of creep
(mainly nonlinear). This effect can lead to a state where the structure is unusable.

+ tensile stress in the reinforcement: stress in reinforcement is verified due to limitation of
unacceptable strain existence and thus appearance of cracks in concrete.

Verification of cracks in cross-section

Load Typeof E. Combi. Ngg Mg, Meg: O h forest Cracks
module [MPa] [kN] [kNm] [kNm] [MPa] [mm] [MPa] appear
Short E. 0 Char. 0 -188 0 12.6 500 29 YES

Stress limitation in concrete

Check type Load Ngg Mg, Meg: yi zZ; Oc Oc im o/0.im Status
[kN] [kNm] [kNm] [mm] [mm] [MPa] [MPa] [-]

§7.2(2) Char. Short 0 -188 0 OFF

§7.2(3) Q.-P. Short 0 -188 0 015 -0.25 -212 -135 1.57 Not OK

Stress limitation in non-prestressed reinforcement

Check type Lload N Mg, Mg vy z; o, O m OJ0., Status
[kN] [kNm] [kNm] [mm] [mm] [MPa] [MPa] [-]
§7.2(5) Char. Short 0 -188 0 009 0.2 300 400 075 OK
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7.6.5. Crack width
The crack width is calculated according to clause 7.3.4 in EN 1992-1-1.

Calculation of cracking forces (uncracked section)
Maximal stress in concrete
gg=12.6 MPa
Cracking forces
Ner =0 kN My =-43.3 kNm Mgz =0 kNm
g =12.6 MPa > o, = 2.9 MPa =»> Cracks appear

Note: The crack is appeared, because maximal tensile stress is greater than cracking strength.

Maximum crack spacing
Smax = 45 mm £ 5*(c+0.5%og) = 275 mmor ppes =0, therefore:

Ky ko -ka- 0.8:0.5+0.425-0.02
Yakerkarbea _ 540045+ =232 mm
Dpett 0.0428

Srmax= k3 C +

Mean strain in the reinforcement

Us_kt'( faer ](1 +0lE'Pp.eff] 060 w

Pp.eff

Esm_cm = Max 3 = j
s g
3 2.9-10°
300-10° - 0.46 - | == |- (1+6.06-0.0428) ;
0.0428 0.6-300-10
=max ; 3 =1.3 %o
200-10° 20010° |

Calculated crack width

W = Em_em - Srmax = 1.3-232=0.303 mm

Limit value of crack width

Wax = 0.4 mm
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7.6.6. Deflection

The calculation of deflection is done according to chapter 7.4.3 from EN 1992-1-1.
The simplified method is used where the calculation is done twice, assuming the whole member to be
uncracked and fully cracked, and then interpolating formula 7.18 according to clause 7.4.3(7). This is the

default used method.

Deflections

Linear deflection
Siny = Uz + Uy =0+0=0mm

Sjinz = Uz + Un =0+ -3.08 = -3.08 mm

Immediate deflection
Gimmy = Uy * ratio,s = 0-2.88=0 mm

Simmz= Uy 1atiogs = -3.08- 2.5=-7.7mm

Short-term deflection
Ssnorty = Uyg *Tatioy, = 0-2.88=0 mm

Osnortz = Uz ratioggs = 0-2.5 =0 mm

Long-term + creep deflection
Biong creepy = Uy* ratio, =0+ 5.22= 0 mm

Siangcreepz = Uz * ratiogn = -3.08-3.38 = -10.4 mm

Creep deflection
Bereepy = Uyt -( ratioy, - ratioys )=0- (5.22-2.88)=0 mm

Bereep: = Un  ratiou - ratiows )=-3.08(3.38-25)=-2.69 mm

Long-term deflection
Biangy = Slong reepy— Sereepy=0-0=0mm
Blang: = Siong creenz — Doeepz = -10.4 - -2.69 = -7.7 mm

Additional deflection
5311:!, =6;m|’!_(+ 6I::n.'wgl:reeo_,' E'l'nm_, =0+0-0=0mm

Saaaz= Sshortz + Slongreepz — Bimmz =0 +-104 - -7.7= -2.69 mm

Limit additional deflection
Baddjimy =0 mm

5 e -10
addlimz = Limagg 500

Total deflection
Buoty = Bshorty + Blongcreepy =0+ 0=0mm

Brorz = Bshortz + ﬁlan; creepz= 0+ -104 =-10.4 mm

Limit total deflection

5{01["113: 0 mm
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7.7. 2D Crack width check

For 2D Members there are fewer checks: the crack width check and the punching check.

The values of the maximum crack width (wmax) are national determined parameters, depending on the chosen
exposure class. Therefore, you can find this value in the setup for National Determined Parameters, via File
- Project settings > National annex [...] > EN 1992-1-1 [...].

B | Concrete setup XK
4 Type of members EN standard Name EN standard
. =
1D k4 Goncicte 4 Concrete
- = General
2D 4 L. Concrete I General
4 Type of values Non-prestressed reinforcement B ULS
o Prestressed reinforcement u
NA building Burability and concrete cover SLS
4 Type of functionality 4 General
Hollow core beams £ Generdl 4 MNational annex
= Punching
Prestressing &4 4 k3 orack - coefficient for calculation m
Value [] 3,40 k
Prestressing o -
4 2
£ Allowable stress k4 crack - coefficient for calculation m E
Stress limitation during tensioning Value[-] 0,42
SLS stress limitation 4w .- for non-prestressed structure 7
= Detailing provisions
Common detailing provisions Values[mm] 0,4/0,3/0,3 L
Columns P Prestressing
Heams & Allowable stress
2D structures and slabs
L. Punching P Detailing provisions
=
F
K
[
< >
=
Select all Unselect all Refresh Load default NA parameters Cancel
]

You can perform the ‘Crack width check’ for all three types of reinforcement: required, provided and user
reinforcement. The crack width check is performed on a quasi-permanent SLS combination.
If you use as type of reinforcement for the crack width either the provided or required reinforcement, you should
choose a ULS combination as well. This is necessary because the required/provided reinforcement is
calculated based on at least an ULS combination. After this reinforcement is calculated, it can be used to
perform the crack width check (this is done automatically by the software).

Required/provided reinforcement

w SELECTION
Type of selection  All -

¥ RESU

RESULTS (1) I\,

Name Crack width (SLS)

Filter Mo

LT CASE

Combination used to perform
crack with check

Typeofload Combinations

Combination  SL5-Quasi (auto)

Envelope

(for2D dra... Absolute extreme v

Provided

Combination used to calculate theoretical
reinforcement used in the check

BV —2024/06/03

Type of reinforcement
Consider user reinfor... @
¥ RESULT CASE FOR REQUIRED REINFORC...
Typeof load Combinations *~

Combination ULS-Set B (auto)
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User reinforcement
RESULTS (1)

Name Crack width (SLS)
w SELECTION
Type of selection  All
Filter Mo

w BECLIT CACE

Combination used to perform

2 Typeof load Combinations ~~
crack width check

Combination  SLS-Quasi (auto) -

- ’ Envelope (for 2D dra... Absolute extreme
Amount of reinforcement is already known,

so no ULS combination necessary L e LA |

Crack width w+

Combination = SLS; Type of used reinforcement = Required; Value = w+

wy [mm]

Crack width w-

Combination = SLS; Type of used reinforcement = Required; Value = w-

w. [mm]

~]
ZARND
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Concrete design

Unity check

Combination = SLS; Type of used reinforcement = Required; Value = UC

1.00
0.25

g

[ [ ] OOOE DODOOoTTt _ AT
[ ' | )

7.8. Punching check

You can find the punching design in the Design = ULS punching.

The beta factor is automatically calculated, and the shape of the column is automatically recognized. You can
choose the method for determining the beta factor in the concrete settings.

Before performing the punching design, you need to set the property panel. Here you need to choose the type
of reinforcement (this is the same as for the crack width check).
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There are three different types of results:
« Green visualization: the concrete can take the concentrated load.

Punching design
Linear calculation
Combination: ULS
Extreme: Global

Selection: N61

Summary

Punching Punching UC wamax UCwac Shear UC wracs
[-1 reinforcement [-1

perimeters
0,52 |not required

case shape [-1

Punching Punching Meay Plate Material der uo Veaw Veamsx UC wramax

case shape ] fea [mm] [m] [MPa] [MPa] -1

[mm] [MPa] P u V edul VRac UC wrac
[%] [m] [MPa] [MPa] [-]

Blue visualization: the concrete cannot take the concentrated load but punching reinforcement can be
designed.

Punching design
Linear calculation
Combination: ULS
Extreme: Global
Selection: N59
Summary
UC vramax  UC vrac Shear UCwracs  UC aswoet
[ reinforcement [l [-1
perimeters

Punching Punching Ves Meay Plate Material derr uo V eaw
case shape [kn] [kNm] h fea [mm] [m] [MPa] [MPa]
B Meaz  [mm] [MPa] P u V edu VRac

[-] [kNm] [%] [m] [MPa] [MPa]

Stu Control perimeters Material Aswreq Asw VRacs
[mm?] [mm?] [MPa)
Aswimin  Aswtt  KmaxVrac  UC aswoe
[mm?] [mm?] [MPa]

Shear Uos UC wracs
reinforcement [m] [mm] (distance/capacity) fywaer [-]

Red visualization: the concrete cannot take the concentrated load and punching reinforcement cannot
be designed.

Punching design
Linear calculation
Combination: ULS
Extreme: Global
Selection: N20
Summary
Punching Punching UC wamax UCwRac Shear UC vracs
case [-] [-1 reinforcement -1
perimeters

0,86 | 1,01 3x 908(radial)

Ve Mesy Plate Material  der uo V gaw0

[kn] [kNm] ] fea [mm] [m] [MPa]

B Meaz  [mm] [MPa] P uy V Edu

[-] [kiNm] [%] [m] [MPa]
19,42 |Ceiing  [C30/37

Control perimeters Material Aswre Asw VRacs

frwaer [mm?] [mm?] [MPa]

perimeters Stos Aswimin  Aswix  KmxVeac
[mm] [mm3] [mm?] [MPa]

Shear Stul
reinforcement [mm] (distance/capacity)
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7.9. Code dependent deformations

The ‘Code dependent deformations’ calculation is a semi-linear calculation and can be found in Design 2>
Code dependent deflection. The calculation is performed, stiffnesses are reduced and the calculation is
performed another time with these reduced stiffnesses to find non-linear deformations. This explanation is
simplified. In the concrete manual you can find the full explanation. Below you can see the values calculated

by this type of calculation.

Name

w SELECTION
Type of selection
Filter

lAutomatic combinat...

Type of load
Combination
Envelope (for 20 dra...
Type of reinforcement

v EXTREME 1D
Extreme 10

E Results in sections

Direction (local)

i I ) G P b
N B -

—— = Output

T 7]
el |

Print combination key

Print explanation of ..

i ~ ERRORS,

| Btot

= Show Information a....

£
£
H

g
i

l 1 Show errors
—— Show warnings
Show notes
g Show table with expl. ..
a " ¥ DRAWING SETUP 1D
Display value name

Display values
Dispiay units
Display case

Display section dx

Display combination...

For 1D member

Oaddy  Oaddlimy  Ototy  Ototlimy

[mm] [mm] [mm] [mm]

Oaddz  Daddlimz Ototz O totlimz

| = RESULTS (1) N

Code depandent deflc

All v
No v

(O]

w RESULT CASE FOR DEFLECTION

Combinations
SLS v
Absolute extreme

User v

Global ~
All v

z{1D/2D) *~

= v

uc

Stot,lim
Gadd
Hadd,lim
Blin
Bimm
Bshert
ereep
Gshr

None ~~

@D

(o)
(O
@
QO
oD
QD

[mm] [mm] [mm]
51 2,500+ |SLS/1 2,21 0,0 0,0 0,0 0,0(- 0,0 20,0 0,0 40,0 | 0,54
User - 3,4 -6,8 -8,0 -2,8 |- 4,1 10,0| -10,9 20,0 [OK
s1 5,500+ |SLS/2 2,21 0,0 0,0 0,0 0,0(- 0,0 20,0 0,0 40,0 /0,03
User - 0,2 0,5 0,5 0,1 (- 0,1 10,0 0,6 20,0 | OK
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Chapter 8: Engineering report

8.1. General interface

The general interface of the engineering report consists of 5 different windows. You can modify the layout of
the interface to your own demands by dragging these windows to the desired position. The windows are
|sﬂown in the following picture provided by an explanation of its purposes.

6 «Hm » af::.::( 8- Report_1 [Bungalow_viewbar_vol t

Jums_rendered_Transparentesa] - Enginesring rpo = &

¥ = & =% | Shortcuts to modify items

Edit pictures Edit external pictures _Tables / Pictures _ Edemalfiles

English (United States)

Property window

nf tha itamc
giine itiems

Added items Preview window

Overview of tasks

o = B Pagewidth - —fp—r +
The engineering report works with items. These items contain all the information that is available in SCIA
Engineer. To add an item into the report, you should double click on the item in the window ‘Available items’
or type the item’s name into the search box of the available items. As soon as you have added this item, it
will be displayed in the tab ‘Navigator’ or ‘Added items’ in the previous picture. You can always change the
added items by using the properties window, which is based on the same principle as in the model space of
SCIA Engineer. You can also modify inserted pictures by using the shortcuts ‘Edit picture properties’, ‘View
point’, ... which are shown in the following picture.

Edit picture View  Edit View
properties point picture parameters

Page 1

Edit pictures

After modifying one or multiple added items, you have to regenerate the content of the report. You can
execute this command for an individual item as well as for the entire report by using the shortcuts
‘Regenerate selected’ or ‘Regenerate outdated’.
(123
\E&G‘) 5]
Regenerate Regenerate
selected outdated™

Regenerate

You can use the shortcut ‘Edit’ to customize the advanced properties of the added items.

7]

Edit

You can modify the language of the report, both in- and output, by adjusting the language in the properties
window of the engineering report.

Properties v & X
Name Report_1 |

English (United States) ~
First page number 1 I
First chapter number 1

Numbering of chapters Structured v
Hide empty items
Swap left / right margins...
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8.2. General page layout

The following chapter contains an explanation of several items concerning the general page layout of the
engineering report.

8.2.1. Page layout

You can select the subitem ‘Style’ to modify the page layout of the report. You can find this item as a
subitem of the available item ‘Special items’. When you have added this item to the report, you can select
the shortcut ‘Edit’. Then the style editor will open. This editor allows you to modify all the settings concerning
the fonts, the spacings and the colours of the text in the report.

Style editor
Read predefined template
‘/ x H E = | Select template v
Cancel Save Load Default
Fonts
Standa [l | Tahoma v
Chapiels }e\re[ no. 1 |
Chapters level no.2 Bold Underline
Chapters level no.3 . .
Chapters level no.4 Italic Strikeout
Chapters level no.5 " 2.Chapter- levelno.1
o 1 1 21 Formatted text
ﬁabte :‘I‘.Er:‘dafd FDntSIZE Lpt] 10 - _V. G ok S fod. Gaple tod SenE ted Semple fedd Shomde ok Sarpin tod. Rample ted Senpl fed Sarpie tedd. Senpie fed.
ElEbE e = Sl 1, Syl b Sapi. bt gl k. gl k. Syl e g bt S o, el s, i, k. o b
T — Sarpl . Safn . i bt Taople b Sarpl k. Stk Sl . Sae bt S
Standard v el
. - O T T T T T
Margins [mmj {left, right, top, thtt_:_r_l_)_}l_ _G_r_a_pf_\_s_)_(_:_ﬁ_ R o
T fesy - e
i 1 02 02 4| St s IEEET )
s
Border {style, width [mm], calor) Graphs X<0
Simple line v o2 [N D -
- et | o - a
Ereak line {style, width [mm] color} ki E
| L0
Simple line v 025 v i E
B Pu——— 2o
Legend for 2D results iz E-
Margins [mm] {left, right, top, bottom) ‘.'.':;
. Lo
2 2 2 = =7 L
: : : : -
i
amt

Content (indent, left indent, right indent, space] [mm]

U

Advanced properties

Space between report items [mm] .5 :
Space between block items [mm] 2
Space between name and item [mm] 1
Space between splitted tables [mm] 5

Style for logical values TRUE, FALSE
User defined strings v X
Color mode >

Mathematical formulas style ..
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8.2.2. Page format and page break

You can adjust the page format of the report by inserting the item ‘Page format’. This item is a subcategory

of the item ‘Special items’. It also contains the item ‘Page break’ by which you can define the end of a
page, for example at the end of a chapter.

Available items A d

+« VAl E G

[=l-Special items
-~ Page break
- Page format

- Header / Footer
Chapter

~Table of contents

-~ Watermark
Style

- Formatted text

- Result picture generator

When you have inserted the item ‘Page format’, you can define all its settings — the format and the margins —

in the properties window.

Properties

BV —2024/06/03

Representation

Name Page format
Caption Page format
Caption visible M

Paper format A4 (210 x 297 mm)
Paper orientation Portrait

Left margin [mm] 10

Right margin [mm] 10

Top margin [mm] 10

Bottom margin [mm] 10
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8.2.3.

Header and footer

You can find the item ‘Header / Footer’ in the category ‘Special items’. Activating the shortcut ‘Edit’ allows
you to define a completely customized header and footer for your report. You can save this item as a
template and apply it in other reports as well.

8.2.4. Chapter

Page layout editor
= Read predefined template Paperformat Paper orientation
« x 7 E Select template - | A4 ~  Portrait Ld
OK Cancel Save Load
|
Select header or footer
Availabl items e L
- z 5 Header
Acceleration of gravity -
Authar [ Switch onfoff Margins (left, right, top, bottom) [mm]
Combi description 1 1
Concrete deformation
Current date Boundaries s
Current date and time T [
Carrent time Left No drawing 0z || - |
Date
Besaltion Add elements to the table
Dynamic
Friis nariohy Add tables
Functionality
Level Height [mm] 20
Licence name g
Licence number
Linear calculation Table ‘ Add table |
Load description Table ‘ Add |
Mational annex EE:E BRI
National code able ‘ |
3 Add text
No. of beams : gcuie
No. of load cases : ‘ Delete |
No. of nodes :
No. of slabs : Item position
LG Horizontal Offset[mm] -20 | Anchor<(;1> 05 Alignment  Left -
No. of used materials :
No. of used profiles : - Vertical 1 0 Top -
Eont TEIER PTEEEEs Edit the position of the table
Calibri - Part Add
Author
Font size 1
s [ oom |
["]Underline Name and value 7
[ strikeout Widths (Name and value) [mm]
I - 0 | 40 Edit table properties

You can create several chapters in the engineering report by adding the special item ‘Chapter’ into the

report.

Available items v I X
+E€e T ER

[=I-Special items | ~

- Page break

- Page format

- Header / Footer

[ Chapter I

- Table of contents

- Watermark

Style

- Formatted text

- Result picture generator

134
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8.2.5. Formatted text

With the special item ‘Formatted text’ you can input text in the engineering report manually.
Available items v I X [

+ € LuEER
| |

[=-5pecial items | ~
- Page break

- Page format

- Header / Footer

- Chapter

- Table of contents

- Watermark

E Formatted text

- Result picture generatar

As soon as you have added this item to the report and you have chosen the command ‘Edit’, you can insert
text in the editor window.

" | Formatted text editor O ®
@ A

[ Add text here ]

[ Add texthere ]
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8.3. Adding pictures

You can also add pictures to the engineering report. You have different methods to insert these items. We
explain these methods in this chapter.

8.3.1. Screenshot or live pictures

As first option to insert pictures into the report you can use the commands ‘Screenshot into Engineering
report’, ‘Live picture in scale into Engineering report’ and ‘Live picture into Engineering report’. These
commands allow you to send pictures of the model to the report and you can access it by right clicking in SCIA
Engineer.

n Zoom

AR Zoom by aut out
Set view parameters for al
Cursor snap setting

Print/ Preview table

e £« B

Table to Engineering report
Print picture

Picture to gallery

Save picture to file

Copy picture to dipboard

%2 Screenshot into Engineering report

Live picture in scale into Engineering report

1 Uve picture into Engineering report

Gy Wired medel n view manipulations
e

Advanced graph setup

I Coordinates info

However, it is important that you are aware of the difference between both types of picture. A screenshot is a
fixed shot, meaning it will not be updated when you modify the structure. Both types of live pictures will be
updated when you modify the structure. You can add the picture into the report by executing the command
‘Insert & Close’.

Picture in scale - Insert objects to Engineering report Inbox x

—- = B s

L I B 40, 2
ug' ét x @ B =] ) B2 [s
Insert Insert Close  Oneat [0 Fit to page

& Close & Close width W) Save -
into sefected report into inbox Picture size Predefined properties

Caption LCla/ Tot. value
Picture size definition Two per page v
Automatic scale to fit size
Scale1:; 101,353614922071

Stretch mode Dark lines v

Rendering Standard -

Antialiasing quality None "

Rotation None =

Result information Inside picture =
Export to PDF as 3D

Position One below another o=

Image raster
Scale for medel data 9,125
Load units in regen. (related to objects created in picture editor only) n
Load activity in regen,
Draw inactive members as is in the window v

Text scale factor 1

Charset of texts Western European, UK, USA (Windows-1252) v
Line pattern length 3 v
Display GCS icon To picture corner v
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8.3.2. Inbox

You can send live pictures or screenshots to the ’Inbox’ of the engineering report instead of immediately into

the report. This option allows you to insert the generated pictures into the report in a later stage. To send
them to the inbox, you should choose the command ‘Insert & Close’ in the tab ‘into Inbox’.

Picture in scale - Insert objects to Engineering report Inbox x
Insert
al —| ; &Y T :L
& Glalx ol 5 5: ;
Insert Insert Insert Close One at £ ¢ Fit to page =
& Close & Close page | il width W) Save -
into selected report into inbox Picture size Predefined properties
Caption LCla [ Tot. value
Picture size definition Two per page

Automatic scale to fit size
Scale 1:

Stretch mode

Rendering

Antialiasing quality
Rotation

Result information
Export to PDF as 3D
Position

Image raster

Scale for model data
Load units in regen. (related to objects created in picture editor only)
Load activity in regen.
Draw inactive members

Text scale factor

Line pattern length
Display GCS icon

101,353614922071
Dark lines
Standard

Nene

None

Inside picture
One below another

0,125

as is in the window
1

3

To picture corner

Charset of texts Western European, UK, USA (Windows-1252)
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8.3.3. Picture gallery

You can send pictures, generated in the model space, to the picture gallery as well. This option allows you to
edit the generated picture without adding data — for example dimension lines — to the model.
You can access the picture gallery by selecting it via the Main Menu -> Libraries > Image gallery.

o fa

£ layers

B Materials

X4 Cross sections

] image gallery
Paperspace gallery

You can send a picture into the picture gallery by performing a right click in the graphical window and selecting
the option ‘Image to gallery’.

q zoomall
Q, Zoom cutout

d' View settings for all entities

TT Printtable

Table to report

TT Printimags Ctri+P

LS imageto gallery [k

(s Saveimage to file

D Copy image to clipboard

[] Screenshot to report

L‘ Live image in scale to report

D Live image to report

,r Wired model in view manipulations
Advanced graphic settings

{{ Coordinatesinfo Ctrl+Shift+D

As mentioned before, you can modify the picture in the picture gallery without adding data to the model in the
model space. To modify the picture, you should activate the option ‘Edit’ in the gallery.

[] Gallery item editor m} X

h RO ® A=l P=I 2 o %3 cdihisil =21,

ke BEFER T KENE o> BH 02 - Myt - A
FEADRANERES BdRF. L8 QAANAQXANBRL S
NG X|Arw 0

ICommand >
Ready NUM

oK Cancel

You can add pictures from the picture gallery to the engineering report by selecting the available item ‘Gallery
pictures’.

— Gallery pictures
Picture1 (1:100) [Analysis model / Steel dz
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8.3.4. Paperspace gallery

The Paperspace allows you to create a plan view of the model.
You can access the Paperspace gallery by selecting it via the Main Menu -> Libraries -> Paperspace

gallery.
o fa
£ layers

'_J Materials
Iy Crosssections
m Image gallery

Paperspace gallery h

After you have created a new paperspace gallery picture, you can add several items by applying the following

functions:
WE . SO0 A Bk

Insert document item...

Insert picture from window

Insert picture from window interactively
Insert picture from gallery

Insert pictures from new picture wizzard

Insert picture from EP3 file ...

Insert picture from EP2 file ...

Insert picture from image file ...

Insert picture from DWG or DXF file ...
Insert picture from VRMLI7 file ...

Load drawing from EPD file ...

Append drawing from EPD file ...
Insert drawing from DWG or DXF file ...
Change template ...

ae X[

8.3.5. Generating result pictures

To create pictures concerning the results of the executed calculation, you have two possibilities: using the
shortcut ‘Indent’ or adding the ‘Result picture generator’. Both options are explained below.

8.3.5.1. Indenting

While composing an engineering report, you can execute the command ‘Indent’. By activating this command,
meaning indenting a table or a picture under an item, SCIA automatically recognizes the relations between
those items and generates the output according to these settings. The following pictures provide a graphical
representation of an indented image under a load case.

Home View

3 Copy Redo
Paste Report
> properties |

Clipboard Undo

=5 ¥ cut 4w Undo - 5 B
I + =
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Edit

Delete  Move
up
Document item

Move
down

Indent

Dutdent
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1.2. Load cases - BG2 1.3. Load cases - BG3

[[Mame | "'i"i‘"i"" %M Name | Description | Action type  Load group | Duration  Master load

8.3.5.2. Result picture generator

The result picture generator is an item which you can find under ‘Special items’. This item requires an indented
result table and an indented live picture.
The result picture generator:

» takes the information about the results from the result table;
» takes the viewpoint of the image;

» views the result set in its properties.

You should define in the properties window of the generator which results need to show in a picture. In the
following example, pictures for the selected results ‘N’, ‘M_x" and ‘M_y’ will be generated.

Properties v o X

“ Representation

Name Result picture generator
Caption Result picture generator
Caption visible V]

Show also result table %

“ Result prescriptions
Draw members selected i... v
N
Vy
Vz
M_x v
2
M_z
V_r
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1. Result picture generator
1.1. 1D internal forces

Linear calculation

Losd case; BGL
Coordinatesystem: Principal
Exireme 1D: Global
Selection: All

1.2. BG3 [ Tot. value - N

Values: N
Linear calculation
Load case: BGL
Coordinate system: Principal
Extreme 10: Global
Selection: All

" 1

%

1.3.BG3 / Tot.value- M_x

Volues: M«
Linear calculation
Load cese: BGL
Coordinate system: Principal
Extreme 10: Glabal
Selaction: All

b

i

1.4.BG3 [ Tot.value - M_y

Values; My
Linear calculation
Load case: 861
Coordinate system: Principal
Extrame 10: Global
Selection: All

BV —2024/06/03

141



Basic Concept Training - SCIA Engineer 24

8.3.6. Report template

You can save a certain layout of a report as a report template. As soon as you have saved this template, you
can import it in a project. The engineering report will then automatically generate all the items of the template
according to the new project.

You can save the layout by navigating to the icon of SCIA Engineer and selecting the option ‘Save as
template’.

©

@3y Print

Template name:

[R Export Temolate descriotion

R, Export after external regeneration

. Save as template

Save as preview template
¢ Store whole report

Store selected part
E‘/ Check report data integrity
Include presentation data

[& Engineering report info Include current page preview image

Lt options b

Exit Stz

NOTE: it is recommended that you save the template in the folder suggested by SCIA. That allows the
software to easily apply the template in your future projects.

The engineering report manager allows you to create a report according to a predefined template by SCIA
Engineering or a user’s defined template. This is shown in the following pictures.

B :
HXE & 5 E

Mew Delete Copy Clean Open Activate Regenerate Close
presentation data

Report Application

@ Engineering report manager x
Seitings Available Templates
BlEl (@ v |
New from template —l —
Hoime
" n

SCIA
templates

User
templates

“annex

Y

A A" ARl

]

142

Result Result sy _DEU _NLD 2D Scheme of  Analysis model Drawing Hsstili tempiateaxdeauit
templates templates reinforcement  description example -
(detautt] (V16 and older] | j
[ [ L L Jis [ L L
EC.ENValues  ECENSteel  EC-ENTimber Eigen IBC - Design  |BC- Steel check IBC - Steel check  Load definition Stability
from national check check frequencies Criteria (ASD} (LRFD)
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Engineering report

8.3.7. Export

You can export the engineering report to several formats as well. These formats are displayed in the following
picture. You can access the export settings by navigating to the icon of SCIA Engineer and selecting the option
‘Export’.

Expprl: report to PDF.
TF Export to RTF i
Expart to Html
% Export afier external regenerstion |——| Opén'éiter aqurt
Export to report |
Save as template | Rendered pictures with high guality - |
= ) Export PDF - = -
— = Expart to Excel | Rendered pictures without antialiasing - |
@ Save a5 preview template
|Export custom range
E/ Check report data integrity, Frarm:

rg' Engineering repartinfo

IFI

ﬂl Options

Splitinto multiple PDF files
Eq Exit

Fages in one file

8.3.8. Print

You can print the engineering report by navigating to the icon of SCIA Engineer and selecting the option ‘Print.
This is shown in the following picture.

@ Report_1 [Fundamentals Training Exercices Steell EH esa] - Engineering report - o x

W Frint = Print
R Export Print Coples 1 E

B Export sfter external regenerstion

SCLAENGINEER

Printer LS
Load cases.

P

E_a Save as template
$ PDFCreator
Ready =

Printer Properties

E’a Save as preview template

¥ Check report data integrity
Settings

ré Engineering report info

||= PrintAll Pages =
Options Print the entire document
P

From 1 To: 4

Ed Exit

‘ EE 16,‘:?1?_2,3 123 4

:
‘ Potii Orntton y

[]
21.59 cm x 27.94 cm

Rendered pictures with high quality

4

4

‘I‘ Page2
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